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CHAPTER 1 Tour of ArCMap

2

A eiz)e) Al

1. Open ArcMap

a) Start ArcMap by double-clicking on the ArcMap icon on your desktop. If anicon is not
present, you can use the Start Menu instead. Usually, you will find ArcMap if you click on:
START BUTTON> PROGRAMS> ARCGIS> ARCMAP 10

b)  When the Getting Started window pops up, click on New Maps under the “Open existing
map or make new map using a template” heading on the left.

¢) Under My Templates, select Blank Map. Click OK at the bottom of the window to open a

blank map in ArcMap.

i ArcMap - Getting Started

Open existing map or make new map using a template
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The ArcMap Graphical User Interface (GUI) will look something like what you see below. If it looks
slightly different, it's because additional functionality (toolbars, etc.) may have been turned on or
enabled by a previous user. When ArcMap is closed, it “remembers” these settings and restores them
when it is reopened.

Explore the ArcMap Interface. As you hold the mouse pointer over a button without clicking it, a
description of its function will appear in a small box below it. Take a few minutes to try out this technique.
As you mouse over some of the icons and buttons, try to familiarize yourself with what each one does.
Some of the major “areas” of the ArcMap interface are labeled below.
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2. Docking toolbars

Toolbars in ArcMap are sets of tools that perform similar types of functions. The Tools toolbar includes
tools for navigating around the map display and tools for performing basic query functions. All toolbars
can be moved around the ArcMap interface and can be “floating” windows or docked to the left, right, top
or bottom of the GUI. The position of toolbars can be manipulated by clicking on the “handle” on its far
left side and dragging it to a new location.

a) Trymovingthe Tools toolbar around the ArcMap window. You can even drag it to a location on
your desktop that’s completely off the ArcMap GUI, just try not to lose it!

@) | (= \U Q MK KN @
\)‘ = M MELD 2 N |
Toolbar /—{}
”
“handle
Q) Untitied - ArcMap - Arcinfo lc:_@&
File Edit View Bookmarks Insert Selection Geoprocessing Customize Windows Help
Oeds B + - Z EEE R P 8L
Table Of Contents a x 79 G
= 3 S hE | &
= layers j
=)
aja £ Qi X @ KSR

@] e n « m '
965.64 214.455 Unknown Units

b) After you have finished experimenting with new toolbar locations, move the Tools
toolbar back to its original position.

3. Add Data

Now that you are familiar with the ArcMap GUI, let’s explore some GIS data. In this step, you will add
data to your ArcMap document. An ArcMap document does not contain the data itself, but rather
includes layers that point to data sources. In this training course, you will be using the VCGI training
dataset, which has been loaded onto your training computer, and can also be acquired at
http://vcai.vermont.gov, by clicking “Data and Imagery” on the left side of the screen, then “products”,
then the download icon & to the right of “VCGI Training Data”



http://vcgi.vermont.gov/

a) In ArcMap, click on the AbD DATA button.

b) Navigate to CAINTROGIS\DATA\ BOUNDARY_TWNBNDS_POLY. Click Abp.

C) Click the ADD DATA button again, and then navigate to
CAINTROGIS\DATA\TransRoad_ RDSMAJ1_LINE. Click App.

d) Click the SAVE button and navigate to C:\INTROGIS\PROJECTS\

e) Save your map as Exercisel.mxd.

4. Explore the Table of Contents

The TABLE OF CONTENTS is the pane at the far left of your screen that lists the data layers that you
have added to your map document— in this case BOUNDARY_TWNBNDS_POLY and
TransRoad_RDSMAJ1_LINE. You will work within the TABLE OF CONTENTS anytime you are in ArcMap
— itis the place to go to access layer properties, attribute tables, and more. Right now you will just get

used to the way ArcMap draws data layers.

a)

Note that TransRoad_RDSMAJ1_LINE is at the top of the TABLE OF CONTENTS, and

BOUNDARY_TWNBNDS_POLY is below it. ArcMap always draws layers from the bottom of
the TABLE OF CONTENTS up, S0 in this case towns are drawn first, and roads are drawn on top
of them. Click on the layer name BOUNDARY_TWNBNDS_POLY and drag it to the top of the

Table of Contents. What happens?

(You should see that the towns now cover up the roads, because they are drawn on top of

the roads layer.)

b) Return BOUNDARY_TWNBNDS_POLY to its original position below

TransRoad_RDSMAJ1_LINE.

c) Click the check box nextto BOUNDARY_TWNBNDS_POLY on and off. Notice the effect this

has.

5. Use the Tools Toolbar to
Navigate Within Data
View

Let’s start exploring some GIS data. The
Tools Toolbar, usually located either
horizontally at the top of the screen or
vertically at the far left of the screen, has
eight tools to help navigate. It also has
several other tools to help you with basic
functions like selecting and identifying
features, measuring distance and area,
and finding XY coordinates on your map.
The most common tools are briefly
described on the picture to the right.

ToolsToolbar
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= Zoom in (draw box)

= Zoom out (draw box)
* Pan

* Full extent

» Zoom in (fixed)

* Zoom out (fixed

* Previous extent

* Go to Next Extent

Navigation Tools

Selection Tools

» Identify



Take several minutes and try using each of the first 8 navigation tools on the TooLS TOOLBAR to see how
each one works. If you get stuck or lose your place, you can always click on the Earth icon on the toolbar.
This is the FuLL EXTENT tool. It will restore the map display to its full extent. We will get to some of the
other tools later.

a) You can explicitly set the display scale of your map by typing a value into the scale window on the
STANDARD TOOLBAR. Try typing in something like “1 inch = 1000ft.” You can also select from a
set of predefined scales. This set of scales can be customized to include a user defined scale.
Giveitatry.

b)  Use your mouse to Pan and Zoom. If your mouse has a scroll wheel, you can use it to zoom
in and out and to pan around the display area. Rotate the wheel forward to zoom out and
backwards to zoom in. Hold the wheel down and then move the mouse to pan around the
display area. This can be a real time saver!
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~ Hold down to pan i }
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\.\\ \LL
Waterbury ;.l" ey i
| \
e 1 \]
1 Middlefield
Cheshire =
]
Frospect e — [
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= —
_j\x /JJ Wallingford j Durham i
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6. Use the Identify Button ()

The Identify button is very handy — it will report to you all of the attributes for any feature that you click on
in your map. By default it works on the top-most visible layer in your TABLE OF CONTENTS, but you can set
it to identify features from a specific layer, from all visible layers, or from all layers.

a) Click on the IDENTIFY button in the TOOLS TOOLBAR, and then click somewhere in your map. If
TransRoad_RDSMAJ1_LINE is turned off, then you will get information for whatever town you
clicked on. If roads are visible, then you will get information for whatever feature you clicked on
—aroad or a town.

b)  Experiment with drawing a box with the IDENTIFY button (this will give you multiple results) and
with changing the layers that the tool works on.

If you get multiple
results, click here
to select between
them

Click the Save button

identify fom: | <Top-most layer> -2
= pbp
Franconia
Lincoln
@)
Location: 1,017,960.029 582,607,696 Feet 4
Field Valse
FID 43
Shape Polygon
AREA 1834924000
PERIMETER 180341.91
PB_ S0
F8_ID 49
FIPS 070
NAME Franconia
COUNTY 9
RPA 1
ACRES 42124.1
< >
Identified 2 features

EI
and close your map by going to File | Exit
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crarter2  AsKing GIS questions and planning
a Mapping Project
Spatial Concerns

When we think about how GIS can be used to help solve problems, we are simply incorporating the idea of a
spatial perspective. An example might be to consider where a new landfill should be placed. You would want to get
a map of rivers to make sure you are not too close to running water, a map of geologic cover types to make sure
you place it on top of relatively impervious clay and bedrock, a slope map to minimize the damage that potential
spills might cause by choosing flat ground, a map of residential locations to keep it away from people, etc.. These
are spatial concerns, and these pieces of spatial information can all be quickly utilized in a GIS environment such as
ArcMap. This thought experiment is referred to as a Suitability Analysis. In a suitability analysis, you are
considering where something should/can exist, and you utilize the relevant spatial data to help you come to that
decision. This is a common form of GIS analysis. If everyone is interested and if time permits, you will perform a
suitability analysis at the end of this training course.

It is always a good idea to plan a project, and planning a mapping project will save you time
and inconvenience! There are a few basic tasks to perform in order to plan your project:

1. Determine the scope of your project
a. Geographic Area:

b. Topic/focus/goal:

2. Audience:

a. How you will share completed project with audience (online,
paper,
etc.):

3. Data needed to complete project:

a. Source(s) of data needed:

b. How you will acquire or create the data:

4. Project partners or participants:

5. Funding:

6. Legal/privacy issues?

12



CHAPTER 3 Acquiring Data

Data is now available from many sources online. Many states, including Vermont, stream data over the
internet, and you can add these data services to your map. ESRI also has a service called ArcGIS
Online to which users can post data, and from which you can stream or download data. In this
exercise, you will see how to access these online data sources. Note that when you stream data, you
are not actually downloading it onto your local computer — you will need an active internet connection
to view the data.

1. Add Data from ArcGIS Online (if you have access to an account)

a) Starta new, empty map (page 6; Chapter 1).

& -
b) Thenclick the Add Data button, ' ™ and browse to
CAINTROGIS\DATA\BOUNDARY_TWNBNDS_POLY.shp, and click add

c) ltis veryeasyto add data from ArcGIS Online — you can do so directly from the same ADD DATA
button on the STANDARD TOOLBAR

1S @S b DB x [0 o[ -[11.4000 U EEEE
RDVMDD B 9 6e% P A0
Jdd Basen ),
Table Of Contents Add Basemap
* ; K e 53 Add Data From ArcGIS Cnine

o

“~

This time, instead of clicking in the middle of the ADD DATA button, click on the tiny triangle just
to the right of it. This will provide a sub-menu of options.

Choose ADD DATA FROM ARCGIS ONLINE.

When the ArcGIS Online window opens, you can type in a search term, such as “Imagery’,
“Elevation”, or “Soils”.

Choose one of the results that you find appealing, and click DETAILS. If you want to add that
layer to your map, click ADD.

It may take a little while for the data to load. When it does, zoom in and explore the data set. Is it
what you expected?

2. Explore VCGI's Vermont GIS Data

VCGI was formerly a public non-profit supported in part by the State of Vermont (through the property
transfer tax) and in part through grants and fees paid for the products and services it provided to clients
(e.g. the VT Agency of Transportation and the VT Enhanced 9-1-1 Board), but it is now a State entity.

13



The storage and provision of free digital geographic data created by members of the VT GIS community
are two of the most important tasks that VCGI performs. Anyone can visit the VCGI Data and Imagery
section of the website to download this GIS data. Newer aerial photographs and some data layers, are
available as Web Map Services (WMS).

a) Open a web browser and go to http://vcgi.vermont.gov

b) Click on the Data and Imagery button to the left on the front page

C) Type Airports into the Keyword search ang'then click on the Go button

ﬁ:.ﬂ il @ vcgivermont.gov

! Jobs | | EmailandBanks | | Food || FunnyandHobby | | GISTools | | School and Resezyd

vermont.gov > vcgi » Welcome ¥, VCGI's Web Page

PN
VERMONT

! About VCGI

VERMONT .cov
official state website

Vermeht Center for b ET

ographic Information

7

i Data and Imagery 4

‘ Resources

[
‘ Education and Training

‘Map Center I

l Events

Welcome to VCGI's Website!

David Brotzman VCGl is your source for Vermont's geospatial data, information, and activities. VCGI is a public
Eroceivn Desclor non-profit chartered by the State of Vermont to assist the Vermont GIS community as well as anyone
58 South Main St interested in geospatial technology or mapping.

Waterbury, Vt 05676

d)  See what information is provided in the search results table

e)  We will not download any data to the workshop computers, but this is something you can do
from your home or office computer (wherever you have ArcGIS available).

3. Stream Data via VCGI's Web Map Service (WMS)

Rather than requiring users to download full datasets (shapefiles, geodatabases, imagery, etc.) from their
websites, many data providers, including VCGI, are making some of their datasets available as live
map services. This is very helpful for many users, as they have access to the newest datasets
automatically, without having to download anything to their computers. The downside is that to display
the data, you need a live (and fast) internet connection.

Currently, VCGI is providing Web Map Services (WMS) of much of their imagery as well as a basemap
(many layers), contours, hillshade, and USGS topographic maps.

In this exercise you will connect to VCGI’'s Web Map Services

a) Click on ‘Data and Imagery’ on the VCGI website’s main page

b) Click on “Web Services”, then “How to Use Web Services” (this will appear just below “Data
and Imagery”)

¢) Highlight and copy the URL provided in step 5 of the “Connecting to GIS Servers in ArcGIS”
section

14
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http://vcgi.vermont.gov/

d) In ArcMap, click the Add Data button.
e) Click the Look jn drop-down arrow and navigate to the GIS Servers folder.

Add Data

F3 GIS Servers v ew@ E-ee
£ Home - GIS\ArcGIS
Name | =5 Folder Connections
HEadd Al Hen

E&jﬁ\dd At B CiGIS

SAdd WY 5 cnGlsedio

EiAdd Wl = cagreedioiResults
2005 = 8

Look in:

tp:f/geosery...

E £ Di\d-cd2 :
& gggg_[ & Toolboxes qttp :Zgzgzzx. 5
‘E 2010 ({7 Database Servers 1% ://groadba' "
e Database Cony ons :
200N & http://broadba...
{12010 | o
sdarcgis @ Track@g Connections L —

[@l Coordinate Systems

Name: e

Show of type: | patasets and Layers v 1

f) Double-click Add ArcGIS Server.

g) Make sure “use GIS services” is chosen, then click Next

h) In the General window, enter the URL you just copied: it should be:
"http://maps.vcgi.org/arcgis/rest/services/" (remove the quotation marks) — don’t enter anything
for a User Name or Password. Click Finish.

i) Double-click the new ArcGIS server (it will now be listed in this GIS Servers Add Data window)
j) Double-Click on the folder containing the service you wish to connect with (basemap is in
VCGI Services, everything else is in EGC services)

k) Click on the service you want to add, then click Add.

i) Explore the data you have added using the Tools toolbar

Now you will add a WMS of aerial photos using a ‘Layer File’

a) Click on Data and Imagery on the VCGI website’s main page

b) Click on Web Services

c) Click on Imagery Services

d)  Click on the first bullet under “Best of Black and White Imagery, Cached, VT State Plane Meters”
It should say “Link to layer file (opens in ArcGIS 10+)”

e)  Awindow will pop up asking you how to handle the file, it should say “open file with...ArcGIS file
handler”, click OK.

f) Return to ArcMap, you should see that the Best of Black and W hite Imagery layer has
been added to your project.

g) Explore this data along with the other data you have added

h)  Save your map document as WMS.mxd, and close your map document using File | Exit

Additional Data Sources:
e The National Atlas (http://nationalatlas.gov/atlasftp.html)
e The Census Bureau (http://www.census.gov/geo/maps-data/data/tiger.html)

15
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CHAPTER 4 GPS and Tabular Data

Collecting GPS data is a common way to get locational information into your GIS. Handheld GPS units
generally save their data in a .GPX format. ArcGIS v.10.2 can import .GPX data, which can then be
transformed into shapefile format (more expensive differential GPS units use proprietary formats only
accessible via separate vender software).

1. Import .GPX Data

GPXis a common GPS data file interchange format. In this exercise you will convert a GPX file to
a shapefile.

a) Startanew, empty map and add BOUNDARY_TWNBNDS_POLY.shp toit. Note that by
adding a data layer with a known spatial reference (like
BOUNDARY_TWNBNDS_POLY.shp, which uses VT’s standard coordinate system: VT
State Plane, units = meters, and datum = NAD 1983), the data frame is assigned that spatial
reference. Add TransRoad_RDSMAJ1_LINE.shp as well.

b) Click on the ArcToolbox icon

c) Click the plus sign next to Conversion Tools, then the plus sign next to From GPS
d) Double-Click on GPX TO FEATURES.

ot L] b

"= [BrcToolbox X
B ArcToolbox S
5 @ 30 Analyst Tools &
= @ Analysis Tools =
3 @ Cartography Tools &
= @ Conversion Tools ¢
& From GPS
& GPXTo Features
5 & From KML
5 & From Raster
7 & From WFS
7 @ Metadata
5 § To CAD
7 & To Collada
5 & To Coverage
5 & To dBASE
5 & To Geodatabase
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d) Navigate to the GPX file “C:\INTROGIS\DATA\vcgipts.gpx”, then adjust the Output Feature
class as the image below indicates and click OK. It takes a minute for the new layer to appear,
This tool converts the default GPX format into the Shapefile format, which is more useful in a
GIS application like ArcMap.

_lojx

Input GPX File El GPX To Features =
I C:\IntroGIS\DATA Weogipts. gpx Eﬁ‘

Dulput Fealre dass Converts GPX files into features.

| C:\IntroGIS\DATA \wegipts. shp B

[ [~

oK | Cancel | Environments... | <« Hide Help Tool Help |

e) Rightclick on the new layer and click Zoom TO LAYER.

2. Re-Project Data

While it is possible to set a specific desired output coordinate system and projection using the
Environments button on the GPX To Features dialog, it is a very common to need to re-project data using
a separate tool. The following steps outline this process.

a) Double click or right click on your new layer to open its properties.

b) Click on the SOURCE tab, and check out the spatial reference for the GPS data

Its coordinate system is GCS_WGS_1984 -- a geographic (not projected) coordinate system, and a
common one used for GPS data. This is not the coordinate system used by your data frame or the other
layers in your map, but that does not prevent ArcGIS from being able to draw the data in the proper
place, because it performs Coordinate Reference System Transformation on-the-fly.

You could simply leave the dataset in its current coordinate system, but that could be confusing for other
users of the data, who have come to expect VT’s standard spatial reference (VT State plane, meters,
NAD 1983). Also, if this dataset were ever the first added to a new dataframe, the dataframe would take
on its spatial reference, which again can be confusing and make other data sets behave strangely.
Finally, accuracy may be improved when all the layers in a data frame share the same spatial reference -
- especially if they will be used for any geoprocessing tasks. Therefore, we will take a minute to project
the data into VT’s standard spatial reference.

In ArcToolbox, browse to DATA MANAGEMENT TOOLS> PROJECTIONS AND TRANSFORMATIONS
> PROJECT (double-click).

NOTE: Do NOT open the tool called “Define Projection” -- all this does is write a text file stating what the
projection is (or actually, just what YOU have said the projection is -- you could in fact define the
projection incorrectly! For example, if you accidentally ran that tool now, you would write a projection file
saying that the Waypoints shapefile uses VT Stateplane coordinates, but in fact it would still be in its old
WGS 1984 geographic coordinates.)

17



c) Setyourinput layer and define the output location and name.
d) Click the icon on the Output Coordinate System line to choose a pre-defined coordinate system.

e) In the window that appears, type Vermont in the search area and hit enter on your keyboard,
open Projected, State Plane, and NAD 1983 (Meters). Click once on NAD 1983 State Plane
Vermont FIPS 4400(Meters) and click OK.

f) NAD_1983_StatePlane_Vermont_FIPS_4400 should now be listed as the output coordinate
system — see image below. Set the output name to something like vgcipts_proj. Click OK. —

Now open the properties of this new layer and look at the spatial reference information under the
Source tab

a
Input Dataset or Feature Class Dutpu
Ivcgipts LI E—’;.l Featur
Input Coordinate System {optional)
| Ges_wes_19a4 | The outg
=———— which th
Qutput Dataset or Feature Class written.
I C:\GIS\IntroGIS vegipts_proj.shp E;-l
Output Coordinate System
I MAD_1933_StatePlane_Vermont_FIPS_4400
Geographic Transformation (optional)
=
WGES_1984 ([TRFO0) To_MAD_1983 + |
x|
OK | Cancel | Environments. .. | << Hide Help | Tool I

Note that using the Project tool creates a new dataset -- it does not simply project the existing dataset.

3. Add X,Y Coordinate Data to ArcMap

In addition to data sources such as shapefiles and TIF images, you can also add tabular data that
contains geographic locations in the form of x,y coordinates to your map.

In this exercise, you will add a text file containing points defined with latitude and longitude.
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a) From the FILE menu, select ADD DATA, then ADD XY DATA

@ Editing.mxd - ArcMap - ArcVi

File | Edit View Bookmarks Insert Selection Geoprocessing Customize '

O New.. CrisN ’ - 14589 v EEE®
& Open.. Ctrl+0 B2 Editor-[»]*
@ save Ctri+S 2 x 29

Save As..

Save A Copy...
~ Add Data | 4 Add Data.. }
B4 Signin. i Add Basemap.. ‘
B3 ArcGIS Online... B3 Add Data From ArcGIS Online... ‘
E3 Page and Print Setup... %v Add XY Data...
@ Print Preview... Geocoding 4
& Print.. # Add Route Events...
&l Create Map Package... % Add Query Layer...

Export Map-.

& Map Document Properties...
1 C\introArcl..\Editing.mxd
2 CAGIS\UNH..\Editing.mxd
3 _\Census_Exploration.mxd
4 CAGIS\...\NH_Browser.mxd
5 C\DriversPe..\Census.mxd
6 _\SPNHF_NAIP_Workmxd
7 _\Deerfield_Browser.mxd WMS
8 _\Composite_AllFocalAr...
9 _\LampreyConservation...

Exit Alt+F4

b) Click the BROWSE button, and browse to
the file CAINTROGIS\NH_Dams.csv.

c) Specify “P_lon_dec” as the X FIELD, and
“P_lat_dec” as the Y FIELD.

d) Click EDIT to change the coordinate system
for the input coordinates. (You need to tell
ArcMap that the coordinates in this new file
do not reference VT’s standard spatial
reference. Rather, they are unprojected
(“geographic”) coordinates -- latitude and
longitude. We will assume that they are
registered to the WGS 84 spheroid, the
most common way that GPS data are
registered.)
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Add XY Data |

A table containing X and ¥ coordinate data can be added to the
map as a layer

Choose a table fram the map or browse for another table:

=

I MNH_Dams.csw

rSpecify the fields for the X, ¥ and Z coordinates:

X Field: IP_Inn_dec j
¥ Field: IP_Iat_dec j
Z Field |E|EV_M j

7

rCoordinate System of Input Coordinates
Description:

Geographic Coordinate System: ;I
MName: GCS_WGS_1934

<

[~ Show Details

v Warn me if the resulting layer will have restricted functionality

About adding XY data oK Cancel




e) Once you have clicked Edit, open the folder for Geographic Coordinate Systems. Within that,
browse to World, and select the last one in that list: WGS 1984. Click OK, then OK again - You may get a
warning about the lack of an Object-ID field -- read through it, and then click OK.

Spatial Reference Properties x|

XY Coordinate System |

1‘ - | IT-;I:IE here to search j Q :'ﬂ-,- | @ . 3

2 TTRF 2005 &

€ ITRF 2008

€ nswe 9z-2

€0 wes 1966

€0 wes 1972

€3 wes 197278

(# 3 cs 1954
£ Projected Coordinate Systems
£ Layers

Current coordinate system:

GCS_WGS_1984 |
WEHKID: 4326 Autharity: EPSG

Angular Unit: Degree (0.0174532925199433)
Prime Meridian: Greenwich (0.0)
Datum: D_WGS_1934
Spheroid: WGE5_1954
Semimajor Axis: 6378137.0
Semiminor Axis: 5356752.314245179
Inverse Flattening: 298.257223563

QK I Cancel
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g) Rightclick on the new layer in the TABLE OF CONTENTS and select ZOoM TO LAYER. This new layer is
a type of temporary file called an Event file — to make it a permanent layer it must be exported

4. Save X,Y Coordinate Data as a Point Shapefile

a) Rightclick on the new layer in the TABLE OF CONTENTS and select DATA - EXPORT DATA.

b) Choose to export all features, using the same coordinate system as the data frame.

NOTE: Depending on your version of ArcGIS, the dialog box may appear slightly different...
just make sure that you are causing the exported data to inherit the coordinate system of the

current dataframe. This is especially important if you started with Latitude/ Longitude (or other)
data and want it to end up as VT Stateplane data.

Export Data

port:  |All features

LIge the same coordinate system as:
this layer's source data

{* the data frame

7 the feature dataset vou export the data into
(only applies if wou expark ba & feature dataset in a geadatabase)

Qutput feature dass:

CAINTROGISDataNH_Dams.shp El

QK I Cancel

21



CHAPTER 5 ArcCatang

1. Open ArcCatalog as a Stand-Alone Program

Now that you have some familiarity with the ArcMap interface, we will open the stand-alone version
of ArcCatalog. (There is also a way to open ArcCatalog (with limited functionality) within ArcMap —
we will do that later.

ArcCatalog is the place to go to manage your data — to move or rename files, to browse through
and preview your data sets, to create new empty shapefiles or geodatabases, etc.

a) Click the ArcCatalog icon on the desktop or, from the Start menu choose ALL PROGRAMS
> ARCGIS > ARCCATALOG 10.

b) ArcCatalogis structured somewhat like Windows Explorer — there is a catalog tree on the left,
and on the right you can see the contents of whatever folder you have selected in the catalog
tree. If you have navigated to a folder and selected a dataset on the left, you can preview it on
the right.

¢) Inthe left-hand pane, navigate to:
CAINTROGIS\DATA\ENVIRON_MAREA2004_POLY.SHP.

d) At the top of the right-hand pane, click on the Preview tab.

7 ArcCatalog - C:\INTROGIS\DATA\ENVIRON_MAREA2004_POLY.shp
File Edit View Go Geoprocessing Customize Windows Help

&erE| BE x| sEHEERQEB BT P
[CAINTROGIS\DATA\ENVIRON_MAREAZ004_POLY shp

BRBE

ORI I

s

| Conterts Preview | Description |

=l E3 Folder Connections
B £ C:y
B arcais
£ pell
E3 pos
B3 grass
[ hidedesktop
B ntel
B EJ INTROGIS
Bl £ DATA
[E]) BOUNDARY_CNTYBMDS_POLY .shp
[E) BOUNDARY_TVINBNDS_POLY. shp
[E) BOUNDARY_VTEND_POLY.shp
[E) CADASTRAL_CONSPUB_POLY.shp
[E]) DEMO_COUSUB2010_POLY.shp
[E]) DEMO_TOWNPOPN_POLY.shp
|j DemoCensus_COUSUB2010. txt
DemoCensus_COUSUB2010.xml
#5 ElevationOther_HILSH24. tif
€7 BlevationOther_HILSH24,prj
=} ErvIRON MAREA2004 POLY.shp
[%7) FACILITIES_PTSCHOOL_POINT.shp

[EC T —
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e) Notice that the same navigation tools (zoowm, PAN, etc.) and the IDENTIFY tool that we used in
ArcMap are available here as well. Feel free to zoom, pan, and identify features in the

preview pane

f)  Right now you are previewing the geography of this dataset. You can also preview its
attribute table. Choose TABLE from the drop-down list at the bottom of the preview pane.

g) Scroll throughthe table to get a feel for the type of information it contains. You will learn
more about attribute tables in the next exercise (and throughout this workshop).

2. Open ArcCatalog within ArcMap

a) When you are finished exploring the ArcCatalog (stand-alone) interface, click the X in the
upper right hand corner of the window to close it.

Note: it is generally worthwhile to close the stand-alone version of ArcCatalog if you are not
actively using it, as it can sometimes lock up your data files and make it so you cannot edit
them or make any permanent changes (like adding attribute fields) to them.

b) Returnto your ArcMap document.

¢) You will now open an ArcCatalog window within ArcMap.

d) Click the ArcCatalog icon in the STANDARD TOOLBAR.

DS B X9 |- [1:154859% v EEE S $e x? .

Opens the ArcCatalog
pane within ArcMap
e) An ArcCatalog catalog tree should appear. Depending on how the last user on your computer

left it, the catalog tree may be floating in the middle of your screen, or it may be docked at the
far right side of your screen. (It could actually be docked at the top, left, or bottom of your screen

also, but most people seem to dock it to the right.)

3. Dock the ArcCatalog Window

One useful feature of ArcGIS 10 is the ability to dock all sorts of windows (such as
ArcCatalog, attribute tables, the Identify results window, etc.) along the edges of the
interface.

a) If your ArcCatalog window is already docked, grab its blue title bar and drag it to the center of
your screen to un-dock it.

b) To dock a window in ArcMap, click on its blue title bar and—with the mouse button still
depressed—drag it a little bit. As you drag it, you will see sets of blue triangles (anchors)
appear. Drag the window until your mouse pointer is on top of the right-most blue anchor
triangle, and then release the mouse button.
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Drag your mouse

Catalog 23] ) )
“- 403 s | % pointer to this
o Horse - GISVAreGls anchor, then
- p - Gl GIS v
= (23 Home - GIS\AreGIS . & r€‘|ease the
\,( g i S mouse button
» (3 Packages
\/ + L3 Default
* ° Toobox
+ L) Foider Connechons
B Tooboxes

{J Database Servers
& Database Conmectons
& GIS Servers

€) This technique works for many of the windows that you will use in ArcMap, though
using the anchors at the sides of the interface has a slightly different effect than using
the anchors at the center of the screen. As you work in Arc-Map, feel free to
experiment with these different anchor locations.

d) Once ArcCatalogis docked, a small pushpin icon appears in its title bar, next to the X.
If the pushpin is vertical, the docked window will always be visible. If the pushpin is
horizontal, the docked window will autohide—that is, it will dis-appear when you click
on another part of the screen until you click on its minimized dock-tab. \

e) Click the pushpinto change whether your window autohides or not. Leave it in
whichever position you prefer. Note that you cannot drag the window about if
Autohide is ON.

[ﬁme;e:. ﬂl [anp:u:llw m [sunsaaﬂl

4. Add Data from ArcCatalog

a) Inthe ArcCatalog pane, expand the Folder Connections folder, and then browse to
CA\INTROGIS\DATA\ENVIRON_MAREA2004_POLY.

b) Click on ENVIRON_MAREA2004_POLY.shp and drag it into your map section of your map
document. This is an easy way to add data to a map document — Explore this data

c) Save your map and close it — choose your own name. (Do this regularly!! It is also a good
practice to save periodic versions of the same map — e.g. EnvrMapl, EnvrMap2, etc.)
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5. Manage Data in ArcCatalog

You can copy, paste, move, and rename data layers in ArcCatalog, as well as create new folders,
shapefiles, or geodatabases. In this example, you will make a backup version of a shapefile and rename
it with today’s date.

a) Inthe ArcCatalog pane, right click on B E3 baTA
ENVIRON_MAREA2004_POLY and choose Copy. 0 vegipts.gpx
b) Right click on the folder name DATA and 2P vegitrks.gpx
Choose Paste. [El) BOUNDARY_CNTYBMDS_POLY.shp
[El) BOUNDARY_TWNBNDS_POLY.shp
c) A new shapefile called [El) BOUNDARY_VTEND_POLY.shp
ENVIRON_MAREA2004_POLYcopy is created. [EJ] CADASTRAL_CONSPUB_POLY.shp

|E) DEMO_COUSUB2010_POLY.shp

[E) DEMO_TOWNPOPN_POLY.shp

[ j DemoCensus_COUSUB2010, tet

DemoCensus_COUSUB20 10, xml
## BlevationOther HILSH24.tif

L, , 3 ElevationOther _HILSH24.prj
6. Optional: View Datasets Using () S —

Windows Explorer ) Facll 2] Copy

LR

e) Rename the shapefile: Rightclick on the new shapefile
and click Rename. Give it the name
Marea2004_BackupYYYYmmdd

You just created a new shapefile using ArcCatalog. It was very easy to do: just copy, paste, and
rename one file. However, what really happened was a little more complicated: seven files were
copied, pasted, and renamed. You can see that this is what has occurred if you open Windows
Explorer to view the files within your shapefile.

The purpose of this step is simply to better understand the files that contribute to a shapefile, and why we
use ArcCatalog rather than Windows Explorer to manage data. You will not be making any changes within
Windows Explorer.

a) Rightclick on the Start button and choose Explore.
b) Browse to CAINTROGIS\DATA\ENVIRON_MAREA2004_POLY

c) Notice how many files are present. A shapefile is not a single file — it is a collection of three
or more files with the same first name (such as ENVIRON_MAREA2004_POLY) and
different suffixes (*.shp, *.dbf, *.shx, *.sbx, *.prj, etc.)

d) Using ArcCatalog to manage your data means fewer steps for you — instead of copying, pasting,
renaming, or moving three or more files, you only have to work on one. It also—vitally—means
far fewer chances for error. It is far too easyto accidentally leave out one of the sub-files
contributing to a shapefile, or make a typo and mis-name just one of them. Either of these
mistakes can be hard to trace back and will make the shapefile unusable.
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CHAPTER 6 Attribute Tables

In this exercise you will explore the attribute tables for the layers in your map and learn how to select
features based on their attributes or their location.

It may seem strange to focus on the task of selecting features based on their attributes or location, but in
fact, making selections is a very useful way to examine your data, and is a frequent first step in analyses.
For example, if you were working on a project based in a specific town, your first step might be to zoom
to that town in your view. You could do that by first selecting the town, and then choosing to zoom to
your selected feature. Your next task might be to sub-set a number of statewide datasets (such as roads
or streams) to just the area of your town. To accomplish this, you would also need to first have your
town selected.

1. Use Select Features Tool

a) Close any open maps and open a hew map document.
b) Add the BOUNDARY_TWNBNDS_POLY_POLY, CADASTRAL_CONSPUB_POLY, and
TRANS_RDSMAJ1_LINE layers

c) Click on the SELECT FEATURES tool on the TooLs toolbar K- , and then click on a feature in

your map.

d) Any feature or features that you selected should now be outlined in bright turquoise.

2. Set Selectable Layer(s)

Particularly when using the Select Features toal, it can be very difficult to figure out what you've
selected once you have clicked somewhere. In the step above, you may have selected some roads and
a town or two with just one click of the tool. There is, however, a handy way to control what can get
selected: the List By Selection tab.

a) Click the 4™ icon from the leftat the top of the TABLE OF CONTENTS — the List By Selection

tab.
A ™7

-] Selected

% BOUNDARY_TWNBNDS... [d [ 1

b) The “regular’ TABLE OF CONTENTS view shows you which layers are visible and in what
drawing order; the List By Selection view instead shows you which layers are able to be
selected and how many features in each are currently selected
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Table Of Co

% 9 Gl o

Selected
CADASTRAL_CONSPUE... [& [d 2

B SAMDBAR STATE PARK
B SAMNDBAR WILDLIFE MAMAGEMENT

&5 BOUNDARY_TWNMBNDS... [E [9 2

& MILTON

® SOUTH HERO
=] %electable (no features selecte
AMS_RDSMAJL LINE [

L]

c) Inthe example above, all layers|are selectable, but only the town bound
features have features selected| BOUNDARY_TWNBNDS_RPOLY_POLYYas 2 features
selected, and they are listed by name — the same goes for CADASTRAL_CONSPUB_POLY.
Experiment with this tool a bit.

d) If you had only wanted to select towns, you could click the Clear Selected Features button next
to the selection results for CADASTRAL_CONSPUB_POLY, and only the 2 towns would
remain selected.

e) On your screen, Clear selected features on one of your layers, and then make it NOT
selectable by clicking the “Click to toggle selectable” button next to it.

f) Returnto the “regular” Table of Contents view by clicking on the first icon from the left at the top
of the Table of Contents: List By Drawing Order. It is probably a good habit to return to this
Table of Contents view, because you will frequently want to do things like turn layers on and off
and rearrange the drawing order (just don't forget if you make layer unselectable).

3. Open and Dock an Attribute Table

a) Rightclick on the name BOUNDARY_TWNBNDS_POLY in the TABLE OF CONTENTS, and choose
OPEN ATTRIBUTE TABLE.

b) Drag the attribute table down and dock it at the bottom of the screen.

ex: If you drag the table by its blue title bar down to the bottom of the screen until the four- way
arrow appears. Hover your mouse pointer over the down arrow, and the table should dock.

If you like, turn on AuTo HIDE by clicking the thumbtack in the upper right hand corner of the
table.
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A menu is available from an OPTIONS icon at the top of the table. Other common tasks (Select
by Attributes, Switch Selection, Relates) are represented by icons at the top as well.

Options Related Selectby Switch Clear Zoom to Delete
Button Tables Attributes Selection Selection Selected Selected

ble [x]
L LT EER
pbp X
FID | Shape* | AREA | PERIMETER | PB_| PB ID | FIPS | NAMI A~
0 Polygon 8120911900 56436363 2 1 7160 Pittsburg
1/Polygon 1738732000 219486.5 3 2| 7040 Clarksville
2 Polygon | 538022910 104318.3 4 3 7005 Atkinson & Gilmat
3 Polygon 1307634000 178369.7 5 4 7190 Stewartstown
4 Polygon 1166271000 139129.91 B 5 7175 Second College
5 Polygon 1370192000 166006.91 7 6 7075 Dixville
6 Polygon 559462530 1055788 8 7 7070 Dixs Grant
7 Polygon 1137201000 1659057 9 8 7045 Colebrook
8 Polygon 1708427000 18940659 10| 9 7050 Columbia
9 Polygon | 536926080 112868.3 1 100 7210 Wentworths Locat
10 Polygon 1935938000 1764295 12 11| 7085 Ermrol
11 Polygon 1260530000 14467209 13| 12 7140 Millsfield
12 Polygon 104616900 42764.129 14 13 7090 Ewings Location ¥
< >
T 0 » » [E]S (©outof 259 Selected)
pbp

c) Click the ADD DATA button and add C\INTROGIS\DATAWATER_WBDS8VT_POLY.shp

d) Rightclickon WATER_WBD8VT_POLY.shp and select Open Attribute Table. Notice that
the WATER_WBDS8VT_POLY.shp attribute table is now docked as well, right where the
BOUNDARY_TWNBNDS_POLY table had been. The BOUNDARY_TWNBNDS_POLY
table is still open, and is accessible from a tab at the bottom left.

Table
ERIE AL =L
WATER_WBDSVT_POLY

FID | Shape | HUC_8 / SUBBASIN
Polygon | 02010007 | M River

Polygon | 01080101 | Upper Connecticut. Ney/Hampshire, Vermont.
Folygon | 02010008 | Lake Champlain Dirgt.

Polygon | 01110000 Riviere Saint-Fragtois

Folygon | 02010005 | Lamoille River/

Polygon | 01080102 P Vermont

Folygon | 02010003 | Winoosid River

Polygon | 01080103 | Copfécticut-Johns River to Waits River. New Hampshire
Polygon | 02010002 | pfter Creek

3

G| 4| | en| e =

<

T 1 ﬁ [E|= | ©outof17 Selected)

€) You can also arrange the tables so they display side by side. To do so, grab one of the tabs
(BOUNDARY_TWNBNDS_POLY or WATER_WBD8VT_POLY.shp) and pull it up toward the
center of the table until the blue docking handles appear. Click on the handle to the right, and the
table will dock to the right, just next to the other table.

Notice that the two tables share one set of tools at the top of the attribute table window (options, select by
attributes, etc.). These tools work on whichever table is selected — that is, whichever table’s title bar is blue.

28



WT_POLY
- BBy O x

| BOUNDARY_TWNBNDS_POLY |

f)

FID | Shape* FIP 56 TOWHNNAME cmﬂ FID | Shape | HUC_& sUBB

» 0| Polygon S030 (CAMNAAN » 0| Polygon |02010007 |Mississquei River

1 (Polygon 11040 | FRAMKLIN 1 1(Polygon (01080101 |Upper Connecticut. Mews Ham)

2 |Polygon 11015 | BERKSHIRE 1 2 |Polygon |02010008 |Lake Champlain Direct

3 (Polygon 11050 [HIGHGATE 1 3 (Polygon 01110000 |Riviere Saint-Franceis

4 |Polygon 11060 | RICHFORD: 1 4 |Polygon |02010005 [Lamaille River

S [Polygon 13005 | ALBURGH 1 5 |(Polygon (01080102 |Passumpsic. Vermont.

& |Polygon 50280 (NORTON : 5 |Polygon |02010003 [Winooski River ’

7 | Bnhinnn GNNE | ANFFRINI i T IPahrmnn I0ANEAANT ICannecticut. Inhne Biver tn 14§ il
1 L|_I 1 r »
4 4 1 M |E 4 4 S Y |E
(11 out of 255 Selected) (0 out of 17 Selected)

|{iATER, WEDEVT BOLY! |

Close the WATER_WBD8VT_POLY.shp attribute table by clicking the X in its upper right

hand corner.

4. Select Features in an Attribute Table

In an attribute table, you can select features by clicking on the small gray box at the far left of a row.

You can click on just one row, drag down for several rows, or hold do

rows.

he Ctrl key to select multiple

| PERIMETER | PB_| PB ID | FIPS |

NAME

OWONOO & WN -

7160 Pittsburg

7040 Clarksville

7005 Atkinson & Gilmanton
7190 Stewartstown

7175 Second College
7075 Dixville

7070 Dixs Grant

7045 Colebrook

7050 Columbia

7210 Wentworths Location
7085 Errol

7140 Millsfield

7090 Emngs Location

TAEN Odalt

Shape * |~ AREA
8120911900 564363.63
1738732000 219486 5
538022910 104318.3
3/Polygon 1307634000 178369.7
o) 4 Polygon 1166271000 139129.91
Click — 5 Polygon 1370192000 166006.91
here to 6 Polygon 559462530 105578.8
7 Polygon 1137201000 165905.7
select 8 Polygon 1708427000 18940659
9 Polygon 536926080 112868.3
10 Polygon 1935938000 1764295
11 Polygon 1260530000 14467209
12 Polygon 104616900 42764129
19 Malioman 1L 400NN 140070 O
‘ 1 » » [B]® (10 out of 259 Selected)
b) Notice what happens to your map display as you select rows in the table.
c)

After you have selected some features, try some of the other buttons and tools
— use the ZOOM TO SELECTED FEATURES, CLEAR SELECTION, and SWITCH
SELECTION buttons — what happens?
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5. Select By Attributes

The Select By Attributes dialogue lets you write a query to select features based on the values in
the attribute table.

SR = T

) FiC)
FID | Shape=\ FIPS6 TOWNNAME | €
3 0| Polygon 9030 [CANAAN
1| Palygon 11040 | FRANKLIN

a) Click the SELECT BY ATTRIBUTES button at the top of the table window.

b) Selectall of Addison County by the following steps (and see picture below for example):
i. Double click on the field “CNTY”
ii. Single click on the = operator
iii. Click the GET UNIQUE VALUES button
iv. Double click on the number 1 (for Addison County)

c) Your statementshould read: SELECT * FROM BOUNDARY_TWNBNDS_POLY WHERE:
"CNTY"= 1 (Note that by clicking on the options as instructed above, you avoid having to know
whether/where to use single quotes/double quotes, etc. You are much better off doing it this way
than trying to type the statementin the dialog window!)

Select by Attributes =
Enter a WHERE clause to select records in the table window.
Method : | Create a new selection V]
“FID" A7
"FIPS6" [
TOWNNAME [
CNTY" N
‘area” -
—] r— .
3 -
; E
foed |
L& Lol i =
G alues | Go To:
= SELECT * FROM BOUNDARY_TWNBNDS_POLY WHERE:
———Pp 'CNTY"=1
Clear ] [ Verify ] [ Help ] [ Load... ] [ Save... ]

d) Click AppLY, then CLOSE. All of the towns in Addison County should now be selected.
e) For more guidance on writing selection queries, click the HELP button in the SELECT
By ATTRIBUTES dialog. ArcGIS’s Help is thorough and accessible, and frequently gives
very useful examples. Queries can be more complex than the ones we use here —
combining multiple expressions, incorporating wild-cards, involving calculations, and so
on. The help text gives many examples that may be quite useful to you.

31



6. Select By Location

In this next step, you will select features based on their geographic location relative to another feature.
Specifically, you will select all towns that Interstate 89 runs through (intersects). First you will need to
select I-89, then you will select towns based on their location relative to 1-89.

a)

b)
c)

d)

e)
f)

a)
h)

k)

Clear any selected features you may already have by clicking the CLEAR SELECTED FEATURES
button on the TooLs toolbar.

Right click on TransRoad_RDSMAJ1_LINE and choose OPEN ATTRIBUTE TABLE.

Click the Select By Attributes button at the top of the roads attribute table.

Double click on the field RTNAME then click the = operator, then click the GET UNIQUE VALUES
button.

Double-Click on I-89. Your statement should read: "RTNAME" ="'] 89'
Click AppLY and then CLOSE.

From the SELECTION menu at the top of your map document, choose SELECT BY LOCATION.

Select BOUNDARY_TWNBNDS_POLY as the =
target Iayer, Trans Road_R DSMAJ 1_|_ INE as the Select features from one or more target layers based on their location in

relation to the features in the source layer.

source layer.

Make sure the box “Use Selected Features”is Target layer(s):

checked — otherwise it will search for any town vl
intersected by any road. You want it to only find [ CADASTRAL_CONSPUB_POLY

BOUMDARY_TWNBMDS_POLY

towns intersected by the selected road: Route 89.

Note that if you wanted, you could apply a search
distance — say, 10 miles — and find any towns that
were within 10 miles of Route 89.

[~ Only show selectable layers in this list
C“Ck O K Source layer:
¥ TRANS_RDSMAI1_LINE =1
V¥ Use selected features (587 features selected)

Turn off the roads layer and, if necessary, zoom to
the full extent of VT so you can see the results of
your selection.

Spatial selection method for target layer feature(s):
Iinbersect the source layer feature j

[~ apply a search distance

[[100¢ |Meters =

About select by location oK Apply | Close

Save your map with a name of your choosing and
close it.
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CHAPTER 7 Joining Tables

As with any other database, you can bring in data tables and join them to the tables in your GIS. In order
to join tables, you need a field that is common to the two tables. For example, if you want to join
population data to your political boundary attribute table, you would need to have a field in the
population data that is the same as a field in the political boundary data. The political boundary data we
are using in these exercises would require that you have population data by town and have a field that
would identify the town by name or FIPS code. In this example, you couldn’t join tables that have the
population information by another geographic designation such as zip code because the shapes in the
political boundary data do not represent zip code boundaries, they represent town boundaries.

The fields in both tables do not have to be named identically in order to join the tables, but they do need
to contain the same information. For example, your population data may have a field entitled “Town”
while the political boundary data’s field is “Name”. You would simply indicate to ArcView that “Town” and
“Name” are fields to use for the join.

Although it is not necessary for the field names to be identical, it is necessary for the corresponding field
values to be identical in order for a join to be successful. In this example, it is important that the town
name be identical in each table. ArcView would not join the Income data to a record if, for example, the
town is identified as “North Hampton” in one data table and “N. Hampton” in the other data table.

The income data used in this exercise is in the Data folder, but can also be downloaded from
http://www.state.vt.us/tax/pdf.word.excel/statistics/2012/,

1. Open ArcMap

a) Start ArcMap with a new empty map.

b) You must be in Data View for Joins to work. If you are not already in DATA VIEW, switch
to it by clicking the DATA VIEW icon at the bottom of the view window.

®; Untitled - ArcMap

=101 x]

Selection Geoprocessing Customize  Windows  Help
1k BIESNAES DR DODBSES %

THCUEE R R R R ||- 'I I:' 2 e
4]

File Edit Wiew Bookmarks Insert

HANQIRill &=

T

OBE|=un 4

-
N [sunsaaﬂ] IXUCIIUDLDJ\!@I'I -

F Python

¢) Navigateto C:\INTROGIS\PROJECTS and save your map as income.mxd.
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2. Join a Layer with a Table

a) Click the AbDD DATA button, and browse to:
C:AINTROGIS\DATA\DEMO_COUSUB2010_POLY.shp and click Add

c)

d)

Next add Median_income_2012.csv

Right-click on DEMO_COUSUB2010_POLY.shp.

e) SelectJOINS & RELATES, and then JOIN...

f) Select JOIN ATTRIBUTES FROM A TABLE.

g) Selectthe field NAME10in Box 1.

h) In Box 2, The CSV You loaded should appear
i) InBox 3, select School District (Town)

Join lets you append additional data to this layer's a
for example, symbolize the layer's features using thié data.

What do you want to join to this layer?

tibute table so you can,

IJoin attributes from a table

/

1. Choose the field in this layer that H}!join will be based on:

records in the target table are shown in the resulting table
nmatched records will contain null values for all fields being
nded into the target table from the join table.

" Keep Wnly matching records

record is removed from the resulting target table.

d in the target table doesn't have a match in the join

{MAME 10 i
2. Choose the table to join to thid layer, or load the table from disk:

I@ Median_income_2012/csv j E‘l

¥ show the attribute tébles of layers in this list
3. Choose the field in thie table to base the join on:

ISchooI District (Tawn) j
r~ Join Options

& ke

Validate Join |

Create Index

X

The join field in the join table you are joining ta the target is nat indexed.

“Would pou like to automatically create an index for the joit field in the join table
now? Doing 2o will significantly improve perfarmance.

Yes |

LCancel

[~ Use my choic%nd do not gshow this dialog again

About joining data \ oK I Cancel |

j) Check the first box (which is the default) to
k) Click OK to join the tables.
1)

about indexing fields in HELP.

ep all records.

If a Create Index window pops up, click YES to create an index. If you like you can read more

m) Right click on DEMO_COUSUB2010_POLY.shp, and select OPEN ATTRIBUTE TABLE.

n) Scroll across the table, and see that it now contains some fields about income.
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0) Also notice that if you scroll down the table, a number of fields contain null values -- this can
occur for a couple reasons — either the names used for the same town are slightly different, or,
the data just don’t exist in one of the datasets. This is more likely the case here. The income
data are split into school districts, which are not the same thing as towns, but the resolution of
these datasets are similar enough to almost be one-to-one

p) Close the attribute table.

3. Save Joined Tables as a New Shapefile

Remember that the tables you have joined -- the attribute table from DEMO_COUSUB2010_POLY and the
income table, Median_income_2012.csv -- are still actually separate tables. This join is just a virtual join, and
when you add DEMO_COUSUB2010_POLY.shp to a new document, none of the income data will come
with it.

If you want to preserve this join, and make it easily available in other documents, you have two options.
You could save DEMO_COUSUB2010_POLY.shp as a layer file, which will keep all of its current
formatting including the join. Or you could save it as a new shapefile, which would not keep the
formatting, but would permanently join the tables.

The layer method has the benefit of not duplicating your data, but also means that if you were to share
the data, you would have to remember to pass on several files: If you save it as a new shapefile, you
would duplicate your data, which makes it harder when you update either the
DEMO_COUSUB2010_POLY.shp shapefile or income table, but your data would all be contained in
one shapefile.

In this exercise you will save the joined data to a new shapefile.

a) If the attribute table is not already open, then right click on
DEMO_COUSUB2010_POLY.shp and select OPEN ATTRIBUTE TABLE.

b) Leavethe ATTRIBUTES TABLE open, right click on DEMO_COUSUB2010_POLY.shp in the
Table of Contents, and choose PROPERTIES.

c) Click on the FIELDS tab.

d) Uncheck any fields that you don’t think you will need in your exported shapefile.

e) Click OK to close the PROPERTIES window, and then close the attribute table.

f) Rightclick on DEMO_COUSUB2010_POLY.shp, and choose DATA - EXPORT DATA.
g) Navigateto CAINTROGIS\DATA\, and name the new file MEDIAN_INCOME.shp.
h) Click OK in the Export Data dialog.

i) Click YEs to add the new data to your map.

i) Rightclick on MEDIAN_INCOME, and open the attribute table.

k) Scroll across the table. Notice that all of the population fields are present, and that the field
names no longer show the source table prefix.

[) Close the attribute table.

m) Save your map.
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CHAPTER 8 Edit Data in ArcMap

In ArcMap, accidentally editing the actual geography of your data (or easily changing its attributes) is
prevented by an extra step: opening an editing session.

In this chapter, you will start an editing session and create new features, define their attributes, and
alter existing features.

1. Edit Features

In this exercise, you will edit an existing polygon shapefile. Using aerial photographs for reference, you
will digitize new polygons and split, reshape, and attribute existing ones.

a) Start ArcMap and open an empty map document. Add some VCGI statewide aerial imagery via
Web Map Service, then add ENVIRON_MAREA2004_POLY.shp

~ Creste Features rx

b) From the CusToMIZE menu, select TOOLBARS, and then click the B - O <Search> -@

£

EDITOR TOOL-BAR. ENVIRON_MAREA2004_POLY

DEN\IIRON_MAREA 2004_POLY

c) Dock the EDITOR TOOLBAR at the top of your screen.

d) From the EDITOR menu on the new toolbar, choose START EDITING.

e) You need to select the folder or workspace in which you will edit.
You can just select the layer (or one of the layers) you wish to edit,
and its workspace will become editable.

f) Double-clickon ENVIRON_MAREA2004_POLY to start editing. o
. . [ Construction Tools
g) The Create Features window may appeatr. It is probably docked at & oy
the right hand side of your screen; if not, dock it there now. g Rectangle
Circle
Editor=|| » " N\ N Heh A B B @ Ellipse
‘? Freehand
=1%” Stop Editing 15| Auto Complete Polygon
B ssvecdts [ | Auto Complete Freehand
Move...
Merge...
# Buffer...
Union...
v
Snapping 3
Mare Editing Tools »
Editing Windows 3 H_['( Create Features |
Options... D Attributes
[ Sketch Properties
{1 shared Features
Adjustment Preview
Control Points
)
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h) The top of the Create Features window displays the layers that are
available for editing. In our example, only
ENVIRON_MAREA2004_POLY is available. When you single-click
on it, Construction Tools appear in the lower window.

i) Start by clicking on Polygon in the CREATE FEATURES pane

ENVIRON_MAREA2004_POLY
[]ENVIRON_MAREA2004_POLY

[cin]
[ Construction Tools
[€3 Polygon
[[] Rectangle
O Circle
© Ellipse

2 Freehand
17X Auto Complete Polygon
| Auto Complete Freehand

f)  Now you will start to digitize an additional managed area to add to the Green Mountain National
Forest. Pick an area to the east of the existing polygons, and not touching them; click all the way
around its border. When you are done, you can double-click or press F2.

The field you just digitized does not touch any of the already digitized areas. If you want, you can
practice drawing a few more isolated polygons.

As you started editing, you probably noticed the semi-transparent FEATURE CONSTRUCTION TOOLBAR that
followed your cursor around. It contains tools that could conceivably be helpful (and that you will use
later in this chapter) but the toolbar sometimes really gets in the way! If you want the toolbar to stay
visible, but get out of your way, just click the TAB button. After you have practiced with editing a bit, you
may decide that you want to close the toolbar and not use it at all; if that is the case, go to EDITOR >
OPTIONS > GENERAL tab and remove the check mark next to “Use mini toolbar.”

2. Save Your Edits

While you are editing, you need to remember to save your edits regularly -- possibly after adding each
new feature.

a) To save your edits, pull down the EDITOR menu and select SAVE EDITS.

b) To save your map, click the SAVE button on the STANDARD TOOLBAR.

Saving your edits and saving your map are two different things. You must remember to save your
edits! Simply saving your map will not do so!!
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3. Reshape an Existing Polygon

If you are not happy with the job you did tracing that field, and want to change
(reshape) a bit of it, there are tools for this

Editor~| » " |[Z] 2 41+ Nihd -2 B3 E‘f&

Reshape
Select tool Edit Vertices

a) Click on the SELECT tool on the EDITOR TOOLBAR.

b) Selectthe polygon you just drew by clicking on it.
c) Click on the RESHAPE tool on the EDITOR TOOLBAR.

d) Starting outside your polygon, digitize a half circle that dips into your polygon and finishes
outside of it again. Double-click or press F2 when you are done.

"< | Create Features 2 x
TE: - B <Search> - @
ENVIRON_MAREA2004_POLY

[ JENVIRON_MAREA2004_POLY

[}
[ Construction Tools

<2 Polygon

[[] Rectangle

O Circle

© Ellipse

2, Freehand

i/ Auto Complete Polygon

| Auto Complete Freehand

d) The field should have been reshaped as if you had cut along that line and discarded the remainder.

| Create Features 2 x
W - B <Search> - @

ENVIRON_MAREA2004_POLY
D ENVIRON_MAREA2004_POLY

=0
[ Construction Tools

<3 Polygon

[] Rectangle

O Circle

O FHlipse

2 Freehand

1% Auto Complete Polygon

| Auto Complete Freehand
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f) See what happens if you do it the opposite way: start inside the existing polygon, digitize a line
that dips out of the polygon and finished inside of it again. Another way to change the shape of
your polygon is to move individual vertices.

g) Click on the EDIT VERTICES tool on the EDITOR TOOLBAR.
h) A new small toolbar is added to your view.

i) You can selectand drag any of the vertices of your polygon. You can use the + and - tools on the
Edit Vertices tool bar to add and delete vertices. When you are done, click F2

i) Save your edits.

4. Digitize Abutting Polygons

When digitizing polygons, one would frequently want to create polygons that perfectly abut one another --
that is, they completely share a boundary, and do not slightly overlap or have small gaps between them.
This would be very difficult to do if you simply tried to trace along an existing boundary as you digitized a
new polygon. Luckily there is a special construction tool just to accomplish it: the Auto Complete
Polygon tool.

Now you will create a polygon for the managed area to fill in an area not currently in the GMNF. Using
Auto Complete Polygon to make it abut an existing polygon.

a) Hold down the Shift key and select polygons surrounding an area that is mostly within GMNF.

b) Choose the Auto Complete Polygon tool

c) Click outside the new polygon\o start delineating the area, click along the approximate
boundary of the area, then double-click outside the polygon_to finish your delineation.

PN ~ | Create Features 7%

¢ -2 <Search> - @
ENVIRON_MAREA2004_POLY

[]ENVIRON_MAREA2004_POLY

i [0}
[ Construction Tools

<2 Polygen
N Rectangle

)
1] Auto Complete Polygon

o 7 | Auto Complete Freehand
e N\
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The actual shape of the area you digitize does not matter right now -- just be sure that you understand
where to start and finish when using this tool. To digitize polygons that perfectly abut other polygons, first
you must select the existing polygons, then start and finish editing within them.

d) After you have completed your polygon, double-click or press F2.

e) Save your edits.
5. Create a New Shapefile

In this exercise, you will create a new shapefile representing either an additional managed area
or something more meaningful to you!

Before you can start drawing the property boundary, you will need to create an empty shapefile to work
in. You will do this in Catalog.

a) Openthe catalog window, and browse to the folder CAINTROGIS\DATA.
b) Right-click on the folder name and choose New > Shapefile.

c) Name your shapefile New_Polygon, and make it a polygon shapefile.

Create Mew Shapefile &
Hame Hew_Polygon
Feahure Type Polygon -
Spaftial Reference
Deesscription:

Urknown Coordinate System

Show Detals

Coordinates will contan M vahses. Lised to store route data
Cocrdinates vl conmn Z valiss. Usad 1o stors 3D data

oK | | Concel

d) Click the Edit button at the bottom of the window to define the new shapefile’s spatial reference.
Choose: Projected Coordinate Systems> State Plane> NAD 83 Meters> then scroll down until you
find the VT coordinate system. Click on it then click on OK. Then click on OK again.

e) Add this new layer to ArcMap, and left click on New_Polygon in the Table of Contents to
change its fill color to none and its outline color to something bright, like orange or fuchsia.

f) Add the TRANS_RDSMAJ1_LINE layer to your map, and click its line symbol in the Table of
Contents and change the width to 4 so that you can see it cle
TRANS_RDSMAJ1

f) Rightclick on New_Polygon in the Table of Contents and select Edit Features > Start Editing.
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g) Inthe Create Features window, click on New_Polygon to display the available construction
tools.

h) With the Polygon tool, begin delineating the property boundary. Start in the southwest corner.
Notice that the FEATURE CONSTRUCTION toolbar follows your cursor around for easy access.
Sometimes, however, it just gets in the way. You can grab its title bar and move it out of the
way. (When you are done editing, save your edits and click stop editing - 'You will not be
able to edit a different layer until you stop your current editing session!!)

Try the various buttons and tools in the editing toolbar and the create features window.
It may be a little hard to tell at first which buttons are “on” and which are “off.” It may also not be

obvious what the function of each button is —remember that Tool Tips will define the buttons for you
if you hover your cursor over them for a moment.

Next you will make a polygon follow the path of a road using the Trace tool.

e Bl 7 A O

\ > TRACE tool

Straight Segment tool

a) From the Feature Construction toolbar, choose the third option — the Trace tool. Click on the
nearest road, and follow it as it forms the boundary of your property.

b) When you get to the end of the bounding road segment, click once to finish tracing, and then
switch tools again. From the Feature Construction toolbar, choose the first option - the
Straight Segment tool.

c) Continue until you have delineated the entire boundary. When you are done, you can double click to
finish your sketch, press F2, or choose the Finish Sketch button on the Feature Construction toolbar.

d) From the Editor menu, choose Save Edits.
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CHAPTER 9 Symbolizing Data

In this exercise, you will work through several different methods of symbolizing data, using town and county
data and 2010 census data. ArcGIS uses the information in a layer’s attribute table (such as county name
or population) to symbolize the data.

After working through some of the Symbology options, you will probably begin to get an idea of how
much work can go into making a data set look the way you want it to. It would be very time-intensive to
go through that effort each time you wanted to use a common data set. Fortunately, you do not have to-
-you can save the Symbology (and more) as a layer file.

In ArcGIS, a layer stores the Symbology, query, labeling, and other qualities of a theme that you have set
in your map document. Your map is really made up of layers -- the document does not contain the data
files themselves, but pointers that reference the data files. But unless you explicitly save a layer file, all
of the Symbology you set in your map is only saved in the map documentitself, and cannot be used in
other maps.

In this exercise, you will learn how to save a layer file outside of your map, so you can later add it to other
maps. When you make a new map and want to include the same kind of features, you can add the layer

instead of the base shapefile, and all of the Symbology will be included. Remember that a layer file does
not actually include the data itself— it references a data set stored elsewhere.

1. Symbolize Using Unique Values

In this example, you will symbolize each county with a different color.
a) Open a new, empty map. If ArcMap is closed, start it up and choose a blank map at the

template/intro screen. If ArcMap is already open, click the NEw MAP FILE button at the upper
left (on the STANDARD TOOLBAR).
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a)

b)

d)

e)

f)

)}
h)

€] New Document @g}
Choose a template for your new map
~

= New Maps My Templates
My Templates
= Templates

= Standard Page Sizes —=
Architectural Page Q ™
150 (&) Page Sizes ~d
North American (A

= Traditional Layouts
Industry Exeter_NRI_Template Blank Map
usa
World

Browse for more... ; :
Architectural Page Sizes

< > ARCH A Landscape ARCH A Portrait v
C:\Documents and Settings\Jim Deely\application Data\ESRI\Desktop10.0\ArcMap\Templates\Nor mal. mxt

Default geodatabase for this map: What is this?
\GIS\ArcGIS\Default.adb v

Choose Blank Map from the New Document dialog.
Click the SAVE button and navigate to CAINTROGIS\PROJECTS
Name your map Symbology.mxd.

In the ArcCatalog pane, browse to INTROGIS\DATA and add DEMO_TOWNPOPN_POLY and
Boundary CNTYBNDS

Right-click on the name Boundary CNTYBNDS in the TABLE OF CONTENTS and choose the last
option, PROPERTIES. (Alternatively, just double-click on the name BOUNDARY_CNTYBNDS.)

Take a minute to browse through the PROPERTIES window (double- click a layer name or right-click |
properties to open this window). This is where you can change all these different properties that affect
how a layer is drawn in your map — including labels, transparency, fields to be displayed, and
symbology.

Selectthe SYMBOLOGY tab at the top of the PROPERTIES window.
Do the following steps to symbolize each county with a unique color:
i. On the far left, click on CATEGORIES, then on UNIQUE VALUES.
ii. From the Value Field menu, choose CNTYNAME.
ii. Click the ADD ALL VALUES button near the bottom of the window.

iv. Choose a color ramp that seems appropriate.
v. Click OK.
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Layer Properties ]
[ General | Source | Selection | Display | Symboloay | Fields | Defintion Query | Labels | Joins & Relates | Time | HTML Popup |

s::»;m Draw jies using unique values of one field.
Categories Value Field Color Ramp
Ui s ‘ - I -
Urique values, many
Match to symbols in a|
Label Count *

Quantiti —
Charts <al cther values> <al other values> 0 ‘
Mutiple Attribiges CNTYNAME 14 I
ADDISON 1 E|
BENNINGTON 1 |l [+
CALEDONIA 1 ‘
< it 1 &
1
1
1
1

» CHITTENDEN
ESSEX
FRANKLIN
GRAND ISLE
LAMOILLE

(amva (s, (i) (o ]

(oK [ cancel | [ eply \

Each county should now have a different color on your map.

You can also classify colors based on values — try using Quantities | Graduated Colors, instead of
Categories, and “area” instead if CNTYNAME — and choose a color
e Notice how your map is now ordered in color by area for each county

2. Change Line Symbology

In this exercise you will change the line symbology for DEMO_TOWNPOPN_POLY.

a) Make sure DEMO_TOWNPOPN_POLY is above Boundary CNTYBNDS in the table of
contents. You will noticed that the towns now completely hide the counties.

b) Double-clickon DEMO_TOWNPOPN_POLY to open its PROPERTIES window.

¢) Make sure you are on the SYMBOLOGY tab at the top of the PROPERTIES window.

d) Do the following steps to symbolize the town boundaries:

i. Click on the color Swa“eneml | Source | Selection | Display Symbology | Fields | D

O

, ih
ii. Choose the hollow color swatch Draw all features using the sam

ii. Click on “edit symbol” bol

Categories
Quantities

g S N

v. Scroll down to learn about various line symbol options. Pick one and click on it.

iv. Click on “outline”

vi. Click OK many times until you are back at your map, with the new town

boundary Symbology applied.
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Q@ Untitled - AcMag p — . - ——

File Edit View Bookmarks Insert Selection Geoprocessing Customize  Windows Help

NEBE& L HEB x » > &b 117me Q%= - 1 I R NP = SR S U S AFgiaa

R THEHE AL SRR A Fa- I Y- &2

Table Of Contants 4 x
e8| =
7 Layers
B |M) BOUNDARY_TWNBNDS POLY
[
5 &) BOUNDARY_CNTYBNOS_POLY
<all other values>
CNTYNAME

I ADDISON

[ BENININGTON

8 CALEDONIA

I CHITTENDEN

3 ESSEX

1 FRANKLIN

" GRAND ISLE

0 LAMOLLLE

I ORANGE

I ORLEANS

B RUTLAND

0 WASHINGTON

0 WINDHAM

W WINDSOR

[t i Iy j@e|on n

j) Save your map!

4. Symbolize with Graduated Symbols

a) In the Towns layer properties window, click on
GRADUATED SYMBOLS under the QUANTITIES heading.

. ol Loy
f«%ﬂ%ﬂ%&}gg‘
b) Setthe VALUES FIELD to POPN2000 o :‘vgngOQ aQ
Lo/
c) Click the TEMPLATE button if you want to change the symbol. fio®s

d) Click the BACKGROUND button if you want to change the
background color.

e) Click OK.
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CHAPTER 10 WOI’kiﬂg With Labels

There are many different ways of adding text to your map -- some are very quick and some will take
quite a while (and can be customized until they look just the way you want them).

In this exercise, you will use graphic labels to label the counties on your census map, use dynamic
labels to define road and highway shield labels, and use dynamic labels to label all the towns in the
state. You will also set up scale-dependent rendering for some of the labels, so that your map is not too
busy with labels when zoomed out, and finally convert labels to annotation so that they can be used
again in other maps.

1. Add Graphic Labels

a) Returnto your population map in ArcMap. It should be saved in the CAINTROGIS\PROJECTS
folder and is called Symbology.mxd

b) If ArcMap is not yet open, open ArcMap using the desktop icon, and select Symbology from
the existing maps list. You may have to click “Browse for More” to locate it.

c) If ArcMap IS already open, click the OPEN FILE icon and browse to the population map.

Make sure that you are in DATA VIEW (not LAYOUT VIEW). One way to identify this is to see if the display
looks like a page of paper, with margins around the edges - this is layout view. You can also check if
the LAYOUT TOOLBAR is active; if you are in data view, each tool will be grayed out (as below).

Perhaps the easiest way to confirm that you are in Data View is simply to click the data view button at the
bottom of the screen. If you are already in Data View it won’t do anything; if you are in Layout view it will
switch you over.

/

(@ =

When you are labeling your data, do so in data view. If you are labeling your map page (such as adding
a title or date), do so in layout view. This chapteris about labeling data, so we will work primarily in data
view.

a) Make sure the DRAW TOOLBAR s visible -- it is often docked at the bottom of the screen, and has
a menu called DRAWING on its left side.

Drawingvm - A- 0] Avial v10 vB I U A-D-2. . F

x

b) Ifitis not already visible, go to CUSTOMIZE > TOOLBARS > DRAW.

c) Turn off all layers except BOUNDARY_CNTYBNDS. You should see just the county boundaries.

d) Choose the TeXT tool from the DRAW TOOLBAR. Do this by clicking the A on the Draw

Toolbar. (It should be the sixth tool in from the left; if it is not available, you may have to click on
the arrow next to whatever tool is visible there, and choose the A from the menu that appears.)

P

0) Arial v10 vB I UA-H-B. ./

Drawing~| R

5
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e) The NEW TEXT tool allows you to type text on your map. If you do this in Data View, the text
will move with your data as you pan and zoom the data; if you add the text in Layout View it will
stay in one place relative to the map page. Here, you will use the NEw TEXT tool to label the
counties, so we are working in data view.

NOTE: When you use the NEw TeXT tool, you will manually type in the text you want on your
map. Later you will use tools that automatically bring in text from the data’s attribute table.

f)  Click in the middle of any county you know and type the name. You can use the
tools on the Draw Toolbar to change the font, font size, color, etc. of your text.
Continue to add county names for the rest of VT's counties. You will need to pick up
the text tool again (click on it) each time you want to type a new name (Don’t label
them all right now, just a couple to practice this method).

FRAMEKLIN ORLE ANS

BENMINGTJN
WINMDH AM
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If you do not already know the county names, this would actually take some effort to figure out from your
GIS data -- you would need to return to the metadata, look at the numerical county codes for the towns,
and find the county name that corresponds to each numerical code.

Note that the text that you add with the NEw TEXT tool is selectable and editable. If you want, you can
select a piece of text and move it to a new location, change its color, double-click on it and change the
text itself, etc. Use the arrow tool on the TOOLS TOOLBAR to select the text. h‘

The arrow tool is a handy, neutral tool to return to whenever you want to “drop” whatever tool you
currently are using.

2. Use the Label Tool

In this step you will practice using the LABEL tool, which will add text to your map by drawing from the
data’s attribute table. You will be labeling individual towns in VT (but not all of them, just a few).

a) Turnon DEMO_TOWNPOPN_POLY in the Table of Contents. Turn off any other layers that
might be visible.

b) Zoom in a bit to focus on a few towns. (A scale of 1:400,000 or so may be good.)

c) Choose the LABEL tool from the Draw toolbar. Do this by clicking the tiny triangle next to the A
on the Draw toolbar -- this will give you a menu of tools to choose from. Select the one that
looks like a little luggage tag.

A Tet
44 Splined Text
& Label
G Callout
IA] Polygon Text f
Al Rectangle Text B
@A Circle Text | mn
Drawing~ Rt O-A - 0) Anal +10 vB 1 U A~ 2. ¢

\

d) With this tool, click a few times in the middle of different towns.

This tool works on whatever VISIBLE layer is on top in the Table of Contents. In this example, we have
only one visible layer, so that is what it is labeling: BOUNDARY_TWNBNDS_POLY. Sometimes, you
may have many visible layers and not want to turn the rest off. In that case, you can temporarily drag
the layer you want to label to the top of the Table of Contents, and remember to drag it back to its
original position when you are done labeling.

When you choose the tool and click on your map, you will be prompted with a LABEL TooL OPTIONS
window. You may use the default options (letting the computer choose the best placement, and using
the properties set for the layer). Alternatively, you can change these options: have it place the label
wherever you click, and/or choose a label style through this dialog.
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Label Tool Options .

Placement
0 Automatically find best placement

(") Place label at position clicked.

Label Style
() Use properties setfor the feature layer.
(@) Choose a style

Label Styles:
U.S. Route US. Interstate =
HWY
AaBbYyZz aBbYyZ
Country 1 Country 2
AaBbYyZz  AaBbYyZ:z
Country 3 Capital -

e) Notice that the computer automatically labeled each town you clicked with the town name as it
is recorded in the DEMO_TOWNPOPN_POLY attribute table. That is because the GIS by

default set the name field as the label field. You can change these settings in the layer
properties.

3. Use Dynamic Labels

It would be difficult and tedious to label every town in the state using the label tool. Instead, there is an
easier option: dynamic labels. This will automatically label every feature in a layer -- in this case,
every town in VT,

a) First, use the arrow tool to select the town labels you just added. k

b) Click the Delete key on your keyboard to delete them. (You can draw a box with the arrow around
multiple labels, or hold down the shift key while you click on multiple labels.)

c) Double click on DEMO_TOWNPOPN_POLY in the TABLE OF CONTENTS to open its PROPERTIES
window.
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Layer Properties =

General | Source [ Selection l Display ] Symbology | Fields [ Definition Query | Labels | Joins & Helates] Time l HTML Popup

7] Labelfeatures in this layer
Method: ‘ Label all the features the same way. X
Alfeatures wil be labeled using the options specied
Text String
Label Field TOWNNAME v [ Bpression..
Text Symbol
0) Aval D
AsBbYyZz ——
¥ W 7 o[ smo. |
Other Options Pre-defined Labe! Style
[ Placement Propetties.. | [ ScaleRange.. | [ LobelStes.. |

OK | [ Cancel | [ Aoy |

d) Click on the Label tab.

For each layer that you add to a map, ArcMap chooses a Label Field -- usually “Name” if that is a heading
in the attribute table. You can change these default settings -- for example, you could decide that you want
to label your towns with their acreage rather than the town name. We will choose “TOWNAME”

e) Puta check mark in the box in the upper left hand corner of the window to “Label features in
this layer.”

fy Click OK.

Hooray -- every town is now labeled! And if you are still zoomed in, it might even look OK. However, as
you zoom out to the whole state, you will see why this method has some drawbacks: the labels are
generally too large for the towns, and -- worse -- they are not selectable or editable. (Try it -- grab the
arrow tool and try to select those labels: it just doesn’t work.)

4. The Label Manager

There are a number of ways that you can refine your labels: change the text size to something smaller;
set a scale dependency so that they only show up when you are zoomed in; convert them to annotation
so that you can edit them individually. If your map is going to always be an electronic map that you will
actively zoom in and out of, changing the text size and setting a scale dependency are good options. If
your map will be a printed map and/or will always be viewed at the same scale, converting to annotation
will allow you to really fine-tune the labels’ appearance.

Like so many things when working with ArcGIS, there are several different paths you can take to get to
the same result. Here, you can refine your labels in two different places: the LABELS tab of the
PROPERTIES window, or the LABEL MANAGER available through the LABELING TOOLBAR.

If you have ArcGIS v.10.1 or higher, you also have a choice of two different labeling methods: the
standard label engine or the Maplex label engine. (Maplex was available in earlier versions, but only as
an extra extension to the software.) The Maplex Label Engine has a number of special tools for
controlling the labels; in general, these will probably make your labels look better, so we will use Maplex
in this exercise.
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a) From the CusTOoMIZE > TOOLBARS menu, choose LABELING.

b) Dock the Labeling toolbar at the top of your screen. The LABELING toolbar and the LABEL
MANAGER that you can access through it work with both label engines -- standard and Maplex.
First you will quickly check out how the LABEL MANAGER works and the label options available
with the standard label engine.

c) Click the firsticon on the toolbar to open the LABELING MANAGER.

Labeling = Pl % *_.-| &N Ex ||Fast o E

Along its left hand side, the LABEL MANAGER displays a list of the feature layers in your TABLE OF
CONTENTS. Along the right hand side, it displays basically the same label options that you would find
in any layer’s PROPERTIES window, such as you worked with in the previous exercise.

Label Manager ]
Label Classes
=-C] TRANS_RDSMAJ1_LINE a TextString
1
-] WATER_WBDSVT_POLY LabelField:  RTNAME -
Default
=[] BOUNDARY_TWNBNDS_POLY Text Symbol
Default e
|0 Arial v 8 -

AsBbYyZz

ERRE

Placement Properties
Orientation Position

Horizontal [¥] above
@ Paralel ]On the line -
i F Below Properties... J
Perpendicular Offset: 0 map units
[ScaleRange,.. ] [ SQL Query... ] [Labelstyles.,. ]
Options '1 [ Clear All J [SUmmary...]
OK ‘ I Cancel

The main benefit of using the LABEL MANAGER when working with the standard label engine is simply that
it collects all the different layers together in one place so you can manage their labels together.

Feel free to apply some changes to the DEMO_TOWNPOPN_POLY label settings. For example, you
may want to experiment with the placement options (horizontal vs. straight (e.g., following the long axis
of the polygon)) or set a scale range. When you are done, click OK to close the LABEL MANAGER.

5. The Maplex Label Engine

a) From the LABELING menu, choose USE MAPLEX LABEL ENGINE.

b) Zoom in a bit if necessary to see the effect of switching to Maplex. You should see that some
town names are now on two lines (“stacked” labels).

nx FATR

T
B <y h % |[Fast 'I
w

l Labeling - 4By &
72)

AJL_LINE
WWT_POLY POULTNEY

WNBNDS_f
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c) Openthe LABEL MANAGER by clicking the first icon on the LABELING toolbar. Note that the
label options are slightly different now.

¢) Change the PLACEMENT PROPERTIES from “Regular Placement” to “BoundaryPlacement”. Click
OK to see the effect of your changes.

e) Scrollin and out on your map to see how the labels scale with your map. (You may find this
easiest using the scroll wheel on your mouse.) Note the scale at which you think the labels get
too crowded -- is it 1:100,0007? 1:300,0007?

f) Returnto the LABEL MANAGER window again. If you like, adjust the font and font size, then click
APPLY.

g) Click the SCALE RANGE button at the bottom of the window.

h) Now click the ScALE RANGE button at the bottom of the label manager window, and within the
dialog that pops up, enter the smallest scale at which you think your labels looked OK. You may
also want to enter a large scale beyond which you wouldn’t want them to display -- it can look
strange to be zoomedin to a very localized area and have a town name in the middle of your map.
Values like 1:500,000 and 1:24,000 typically work pretty well.

Scale Range l ? ﬁl

e

You can specify the range of scales atwhich labels will be shown.
Use the same scale range as the feature layer.

@) Don't show labels when zoomed:

Outbeyond: 1:500.000 v (minimum scale)
L
In beyond: 1:24,000 » (maximum scale)
ll [ ok | [ cancel | |

i) Click OK and OK to close the LABEL MANAGER window. Zoom in and out on your map to
explore the scale dependent label rendering you just set up.

6. Convert to Annotation

If you want to really get into your labels and change them individually, you have two options: either you
can start with graphic labels (like the County labels you added manually), or you can start with
dynamic labels and convert them to annotation.

Annotation is wonderful in that it can be saved outside of your map in a geodatabase and added to
multiple maps, just like any other data set. Each piece of text (such as each town label) is a separate row
in an attribute table, and all of the text’s properties (font, angle, color, etc.) are attributes in that table.

The downsides to using annotation are that it can be time-consuming to set up (though if you use it
frequently, it will certainly save you time in the long run); the labels are no longer dynamic -- that is if you
change a value in the source data (like fix a typo in a town name), that will not be reflected in the label;
and they are specific to one map scale -- they will not zoom in and out with your data. So annotation is
most useful for printed maps and electronic maps that are intended for a specific scale.

56



In this exercise, you will convert town labels to annotation for a hypothetical map that will be at 1:200,000.

a) Zoom your map to 1:200,000.

b) Make sure your town labels are visible and are an appropriate size for this scale. If not, make
the necessary changes in the BOUNDARY_TWNBNDS_POLY properties window to fix it.

c) Create a geodatabase in which to store your annotation. From the catalog pane, expand the
catalog tree so you can see the INTROGIS\DATA folder. Right click on the folder and select
NEW > FILE GEODATABASE.

d) Name the new geodatabase TownAnnotation.gdb.

Thompson & Mesene ~ (Catalog B x
s v elr@|E-|slE
53 Pischese Location: [ PoliticalBoundaries Y
S e # 1 0316300ada0581b13111e8d6 -
165596 ac + £3 Config.Msi
+ £ Drivers
+ 3 DriversPermit10
+ £ GIS
= £ IntroArc10
Qutts Grant - £ Data
72188 ac. = 0
=) pba.sh & Copy
pbpsh & Paste
Jackson
2158 3¢ #ERoads | x pelete
# &3 Projects R
# £3 MSOCache siling
+ [ PerfLogs ~ Refresh
E1 Folder ~ New » -
Hodleys Purchiase \1! File Geodatabase ] Item Description...
47404 a¢. 3 Personal Geodatabase B Properties..
3 Spatial Database Connection...
&1 ArcGIS Server Connection...
> Layer.. raw
?;;;ﬁm Bar ) ‘Graup Layer am_AerialPhotos
47883 ' Shapefile... |AerialPhotos
Toolbox
dBASE Table

Address Locator...
Composite Address Locator...

HeeHo

XML Document
+ &1 DRGs
+| E3 DrinkingWater
# 3 Ecoregions

e) Rightclick on the layer name BOUNDARY_TWNBNDS_POLY in the TABLE OF CONTENTS and
select
CONVERT LABELS TO ANNOTATION.

f) Inthe window that appears, confirm that the selections are to store annotation in a database
and the reference scale is 1:200,000.

g) Click the browse button to identify the geodatabase where the annotation will be stored
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h)

Convert Labels to Annotatiol

Store Annotation Reference Scale

Q)In a database In the map 1:200.000

Create Annotation For

Q) All features Features in current extent

Feature

Linked Annotation Feature Class

Bk T

8

Feature Layer

Destination:  Unknown

v | Convert unplaced labels to unpl: Convert ‘ Cancel

Browse to the new geodatabase you just created and double-click to open it. Click SAVE.

Instead of the default name BOUNDARY_TWNBNDS_POLYANno, name the new feature
class BOUNDARY_TWNBNDS_POLYAnno_200k. This way you know the scale at which the
annotation should be used. You could conceivably create several different annotation layers for
different scales.

Click CONVERT.

Notice that a new layer has been added to the TABLE OF CONTENTS -- this is the annotation. Turn
it off, and then on again.

Because it is a new layer, just like the other layers in your map, it can now be edited.
However, that will require starting an editing session - We will work on that later in the Develop
New Data chapter.

m) Turn the layer off for now, as the next exercises will work on adding other refinements to

a)

b)
c)

dynamic labels.

7. Use a Label Expression

So far, you have used a field directly from the attribute table to label your data. You can instead
formulate an expression for your labels. In this example, you will label each town with its name AND
acreage.

Openthe DEMO_TOWNPOPN_POLY Properties window again. On the label tab, check the
box at the top: “Label features in this layer.” (This turns the labels back on; converting to
annotation earlier automatically turned them off.)

From the Label tab on the PROPERTIES window, click EXPRESSION.

Enter the following statementin the Expression window:

[TOWNNAME] & vbNewLine & round(([area]/1000000),0) & " sq. Kilometers"
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d) You can also enter the field names [TOWNNAME] and [area] by clicking on them in the field list at
the top of the Expression window.

Label Expression =
o v

Fields

Double-click to add a field into the expression Show Type
FID ®
FIPS6
TOWNNAME
CNTY

area
len

] Display coded value description

Expression

Write the expression in the language of the selected parser.  [] Advanced

[TOWNNAME] & vbNewLine & [area] "sq meters”

»

[ veify ][ Reset | [ Hep ][ Load.. ][ save.. |
parser
=

This is a great place to click the HELP button -- it gives a lot of examples of ways to build expressions,
with helpful reminders of the necessary syntax.

e) Click OK, and then OK again to apply your changes. Depending upon the current scale of
your map, you may need to zoom in to see the labels.

f)  Once you have checked them out, you can turn them off. The quickest way to turn labels on
and off is just to right click on the layer name in the Table of Contents and click on Label
Features.

g B Copy
X Remove
B Open Attribute Table
Joins and Relates »

e -

v Zoom To Layer

.

Visible Scale Range 4

[ Use Symbol Levels
Selection »

Label Features

o

Edit Features ¥

Convert Labels to Annotation...

¢

&
i}

o Convert Features to Graphics...

Data »
Save As Layer File...
Create Layer Package...

fa

Properties...
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8. Save a Layer File

The changes you made to the layer properties for DEMO_TOWNPOPN_POLY can be savedin a layer
file -- as can all the settings in the Properties window. This way, the next time you add the
DEMO_TOWNPOPN_POLY.lyr layer to a map, it will include the label settings you just designed.

a) Rightclickon DEMO_TOWNPOPN_POLY in the TABLE OF CONTENTS.

b) Choose SAVE As LAYER FILE. o & Copy
X Remove
c) Browseto C:\INTROGIS\DATA OpenAttnbute Table
Joins and Relates 4
d) Save your map. 1 @ Zoom To Layer
Visible Scale Range 4

Use Symbol Levels

Selection »
v | Label Features

Edit Features »
+4 Convert Labels to Annotation...

%o Convert Features to Graphics...

\ Data »

Save As Layer File...

@ Create Layer Package..

T ™ Properties...

You may have noticed that sometimes labels take a long time to draw each time you zoom or pan your
map. You can click the PAUSE LABELING button on the LABELING TOOLBAR to just stop labeling for the
time being. You will need to click the PAUSE LABELING button again to resume labeling.
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CHAPTER 11 Introduction to Geoprocessing:
Dissolve and Buffer

In this chapter, you will evaluate lakes and ponds in a particular county within VT. Your goal is to
identify any waterbodies larger than 10 Acres, establish a 150 foot buffer zone around those
waterbodies, and report the total acreage of lakes and ponds plus buffer within the watershed.

You will use the following processes and tools to complete the analysis: select by attributes, select
by location, export, dissolve, buffer, calculate geometry, and statistics.

1. Set Up Map Document

a) Open ArcMap.

b) Atthe start screen, choose a template for your map. Go to TEMPLATES - STANDARD PAGE SIZES -
NORTH AMERICAN (ANSI) and highlight TABLOID (ANSI B) PORTRAIT. DON'T HIT OK YET!!!

Q ArcMap - Getting Started

Open existing map or make new map using a template

—-Existing Maps ; =
; Recent Legal Landscape Legal Portrait
Browse for more...
[=)-New Maps
My Templates
= Templates
| —J-Standard Page Sizes

Architectural Page
\ 1S0 (A) Page Sizey|
North American (A| Letter (ANSI A) Landscape Letter (ANSI A) Portrait

[=)-Traditional Layouts

Industry
USA
World

Browse for more...

1

Tabloid (ANSI B) Landscape [Tabloid (ANSI B) Portrait]

< 11} 3 -

C:\Program Files\ArcGIS\Desktop10.0\MapT I tandard Page rth American (ANSI) Page Sizes\Tabloid (ANSI B) Portrait.
Default geodatabase for this map: What is this?
C:\Users\Anne\Documents\ArcGIS\Default.gdb \l B ]
E—
Do not show this dialog in the future. [ OK l Cancel J

Now you will define a default geodatabase for the map -- this will be the geodatabase where you put any
results of your processes. You do not need to define a default geodatabase,and in fact you could keep all
of your results as shapefiles, but it is handy, and is a best practice to put it %II in one geodatabase.

c) Click the browse button next to the default geodatabase pathname!

d) Browse to C:\INTROGIS\DATA.
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@ ArcMap - Getting Started =)
Open existing map or make new map using a template

5 Existing Maps
Recent
Browse for more...
= New Maps
My Templates
£ Templates
) Standard Page Sizes|
Architectural Pag
1S0 (A) Page Siz|
North American {
- Traditional Layouts
Industry
usa
World
Browse for more...

ANSI D Portrait ANSI E Landscape ANSI E Portrait

Legal Landscape Legal Portrait Letter (ANST A) Landscape

- Letter (ANSI A) Portrait Tabloid (ANSI B) Landscape Tabloid (ANSLB) Portrait
‘ m V u

C:\Program Files Desktop10. 1 Page Sizes\North American (ANST) Page Sizes\Tabloid (ANSI B) Portrait.mxd

Default geodatabase for this map: What s this?

C:\INTROGIS\DATA akesponds. adb =

7100 not show this dislog in the future.

e) Click the NEw FILE GEODATABASE button.

o——— ——— ™k
Default Geodatabase \ ﬁ
|| Look in: [EAshuelatPond V] LB EY RS

B AshuelotPond

Name: AshuelotPond.gdb Add

Show of type: {Geodatabases v] l Cancel ]

d) Name your new geodatabase LAKESPONDS and hit enter.
e) Select the new geodatabase, LAKESPONDS, and click ADD.
On the opening dialog, click OK.
f) Click the DATA VIEW button to switch away from LAYOUT VIEW.
g) Save your map in the PROJECTS folder. Name it LAKESPONDS.mxd.

2. Select By Attributes

The first step is to figure out where the Winooski River watershed is, and then you can select all the
lakes and ponds 10 acres or bigger that are within it.

a) Openthe Catalog pane and add three data layers:
CAINTROGIS\DATA\BOUNDARY_TWNBNDS_POLY.shp
CAINTROGIS\DATAWATER_DLGLAKE_POLY
CAINTROGIS\DATA\WWATER_WBDS8VT_POLY

b) Right-clickon WATER_WBD8VT_POLY and choose OPEN ATTRIBUTE TABLE.
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c) Click the SELECT By ATTRIBUTES button at the top of the table window. (If you aren’t sure which
button it is, hover your pointer over each until the tool tip appears and you find SELECT By

ATTRIBUTES).
= —

Select by Attributes M

Enter a WHERE clause to select records in the table window.

Method : | Create a new selection '}

"FID"
"HUC_8"
"SUBBASIN"

[fm] »

"HUC_4"

E 'Passumpsic. Vermont." -
E:;?Ci:nmezt'lac::o:ew Hampshire, Venr
(ou) | e .

A= :
[E] Get Unique Values | Go To:

SELECT * FROM WATER_WBD8VT_POLY WHERE:
"SUBBASIN" = 'Winooski River’ .

[ cear | [ veity |[ Hep | [ Load.. | [ save. ]

[ fpy ][ Gose ]

d) Create the following expression: "SUBBASIN" = 'Winooski River'

e) Click AppLy, then CLOSE.

f) Click the Zoom TO SELECTED button at the top of the table window.
Close the attribute table
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3. Select By Location

Now you will select any lakes and ponds polygons that intersect the selected watershed
a) If you haven'talready, turn on the WATER_DLGLAKE_POLY layer.
b) From the SELECTION menu, choose SELECT BY LOCATION.

¢) Choose to select features from the target layer, WATER_DLGLAKE_POLY, thatintersectthe
source layer, WATER_WBDS8VT_POLY. Make sure to check the button next to “Use selected

»
features
-
N
Select By Location &J

Select features from one or more target layers based on their location in
relation to the features in the source layer.
Selection method:
[select features from ha
Target layer(s):

WATER _DLGLAKE_POLY

[] WATER_WBDSVT_POLY

[ BOUNDARY_TWNBNDS_POLY
[ only show selectable layers in this list
Source layer:
[€ WATER wBDSVT_POLY |
[V] Use selected features (1 features selected)
Spatial selection method for target layer feature(s):
intersect the source layer feature B

Meters
OK J I Apply ] l Close }
\
d) Click OK.

The lakes and ponds within the Winooski Watershed should all have been selected. If all the lakes and
ponds in the state were selected, you may have forgotten to check the “Use selected features” option,
or you may have accidentally cleared your selected watershed. Repeat the above steps if necessary to
select the appropriate wetlands.

4. Export to New Layer

Right now the lakes and ponds within the Winooski Watershed are all selected, but that selection would
be easily lost if you accidentally clicked the clear selection button. Make the selection permanent by
exporting those lakes and ponds to their own layer (in this case, not a shapefile, but a feature class
within your geodatabase).

a) Rightclickon WATER_DLGLAKE_POLY and choose DATA > EXPORT DATA.

b) Click the browse button to browse to your new geodatabase.
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c) Click the Go To DEFAULT GEODATABASE icon at the top of the Saving Data window to navigate
directly to your default geodatabase. Name your new feature class WinooskiW S _lakesponds.
Make sure that the file type is set to File and Personal Geodatabase feature classes rather
than Shapefiles.

Saving Datal o
Lookin: |LALAKESPONDS.gdd v @vis o
Name: WInDoSKIVS_izkesponds | save
Save 25 type: | file and Personal Geodatabase feature dlasses v Cancel

d) Click SAVE, then OK.

e) Click YEs to add the resulting data as a layer.

f) Remove the state-wide lakes and ponds data. Right click on WATER_DLGLAKE_POLY and click
REMOVE.

g) Click on the clear selected features button in the toolbar.

h) Save your map.

5. Summarize Data by an Attribute

The lakes and ponds in this watershed have various values for RECCODE. You can easily calculate
the acreage of wetlands in each of these categories using the Summarize function. Note that this will
create a new, stand-alone table not connected to the geodatabase.

a) Open the attribute table for Winooskiw S_lakesponds.
b) Right click on the field RECCODE and choose SUMMARIZE.

c) Expandthe ACRES field and select Sum. Name the output file Winooski_ponds_types_acres
and save it in your geodatabase.

64



sert Selection Geoprocessing Customize Windows Help

g Summarize [ : ! Hek
™| Summarize creates a new table containing one record for each unique value
of the selected field, along with statistics summarizing any of the other fields. =z A
1. Select a field to summarize:
RECCODE v
2. Choose one or more summary statistics to be included in the.
output table:
@ CODE .
@ WATERBODY
@ NAME
£ ACRES
(] Minimum L
[ Maximum
 Rase || saving Data
¥ Sum = -
[] Standard Deviation | | ookin: |3 lakesponds.qdb v &3 g
= [ Variance i L
s Name Type
3. Specfy output table:
C:\INTROGIS\DATA\winooski_ponds_reccodes_acres.dl E]
d |
g Simmaxize on the selected records only
7]
ot snmsang dts Cance
E
E] El gl E] 0 995 |
52| 29 1 El 7 3
52| 208 1 El 1| VT17-01L01 4| LAKE] | Name: ‘winooski_ponds_reccodes_aaes.dbf [Csave ]
B2| s3] 4 El 0 | VT17-03L02 4| GREA]
52| 43 -1 -1 0| VT17-02L04 4|HOLLY | Saveastype: [Fiie and Personal tables v] [ Cancel ]
0 0 0 0 0 3
(0 out of 960 Selected)

d) Click OK, and add the resulting table to your map.

e) Becauseiit is a stand-alone table and not attached to locational data, the TABLE OF CONTENTS will

switch to “Source” view so that you can see the new table. To open it, right click on its name and
choose OPEN.

f) Create a new field in this table by using the Table Options drop down menu on the top left of this
table and choosing “Add Field” — call the new field Acres, and choose “Double” for the type

EREE %ﬁgy@ x

B8 Find and Replace...

EL select By Atiributed...

i

Eﬁ Switch Selection

Select Al

RECCODE | Count_RECCODE Sum_area
1 0 3 1777516.32535
2 2 10 1520354.43015
3 3 8 3180646.81645
4 4 9 89132541377
5 999 89| 1131779646.205649

|| Add Field... |

f) Right click on the field name Acres and choose FIELD CALCULATOR. Calculate the field Acres to be

equal to ([Sum_ACRES]/0.0929)/43560.

-
Feeld Calculator

(X

S _pves] 0.0529) 5580

Types

0 Mumber

i

§95 78958 3

8

-~
-

g) Notice that you could have also created this Acres field when you were making this Summarize table by choosing
to sum Acres as well as area, although many Field manipulations are done using the field calculator as above
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6. Dissolve Boundaries

a) Add ENVIRON_MAREA2004 POLY to your map. This is “Managed Area” that is largely
within Green Mountain National Forest. Right click the layer's name in the table of contents
and choose zoom to extent. Then zoom in to a scale of about 1:100,000 and pan to an area
with a lot of features.

b) Using the IDEI\\ITIFY tool, draw a box around multiple “managed areas”.

Selectio Geoprocessing Customize Windows Help
b - | 4100000 > Z|EEE £ Editor~
LI R :

s
“L

Location: 465,632.389 169,392.664 Meters

_| Field Value

| Fi0 25

" | shape Polygon
MACODE  8.1A
TRACT_NR

ACQ_DATE  12:00:00 AM
GIS_ACRES 1988.790033
OWNER  GMNF

area 8048522.6797
len 52727.573936

Identified 27 features
Drawing~ K - A~ 0] Aral vi0 vB I U A-H- 2.«

c) Click on several of the features listed in the top window. You will notice that the
individual delineated areas highlight as you click on them.
d) Close the Identify Window.

We will use the dissolve tool to remove the internal boundaries between these smaller polygons.

To find the DISSOLVE tool, you can either browse through the SYsTem TooLBox (found at the bottom of the
Catalog window) and hunt & peck through it, or add the SEARCH window and use it to find the tool.

The search feature can be used to find maps, data, and/or tools. You can add new file folders to its
index and set its indexing options by clicking the options button.

Before you can search a new folder or location, you need to set the location on your network in
which you want to enable your search. This is done by adding a location and creating an index of
the tools and data available (this process is not needed to search for built-in tools like Dissolve).

d) Click the SEARCH window button at the top of the screen.
e) Click the INDEX/SEARCH OPTIONS button.
f)  On the INDEX/SEARCH OPTIONS dialogue, click AbD.

g) Browse to your CAINTROGIS\ directory and click SELECT. At the bottom of the dialogue, click
INDEX NEW ITEMS. When the indexing status is set to Active, the new index is built and ready
for search. Click OK.
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it to AUTO HIDE.

Type “Dissolve” in the text box and hit enter.

Dock the SEARCH window on the right hand side of the screen next to the CATALOG window. Set

Select the DIssOLVE (DATA MANAGEMENT). Note that there are 3 hyperlinks for each result. The
first link opens the tool itself, the second link opens a Help description of the tool
link locates the tool within the toolbox folder.

the third

Search

L |@ < |g - ILDcaISearc:h
ALL Maps Data Tools Images
Idissolve

Any Extent +

Search returned 7 items

#, Dissolve (Coverdge) (Tool)

Creates a new coverage by merging adjacent pol

toolboxes\system toolboxes\coverage tools.thx\data mana...

"\ Dissolve (Data Management) (Tool)
Aggregates features based on specified attributes.

toolboxes\system toolboxes\data management tools.thx\g...

fx Dissolve Network (Network Analyst) (Tool)

Creates a network dataset that minimizes the number of li...
toolboxes\system toolboxes\network analyst tools.tbx\net...

"\ Dissolve Route Events (Linear Referencing) (Tool)

Removes redundant information from event tables or sepa...
toolboxes\system toolboxes\linear referencing tools.thad\di...

Occasionally tools from the search results can be difficult to open on the workshop computers. If your

dissolve tool does not open, expand the Catalog window and scroll down to the bottom so you can see
the SYsSTEM TooLBOX. Then click the third hyperlink in the DISSOLVE (DATA MANAGEMENT) search results
(“toolboxes\system toolboxes\data management tools.tbx\generalization\dissolve”) -- this should locate
the tool within the toolbox folder, and you can open it from there.

4 Dissolve =)
| C:AINTROGIS\DATA\ENVIRON_MAREA2004_POLY.shp ~] &
Output Feature Class ’
C:\INTROGIS \DATAVakesponds.gdbMAREA2004_POLY Dissolve @
issolve_Field(s) (optional)
[F] FD
[7] macope
[7] TRACT_NR
[] ACQ_DATE
] GIS_ACRES
7] oWNER
[T] area
[T len
Statistics Field(s) (optional) E
Field Statistic Type @
x
1
4
< i v
(] Create muttipart features (optional)
[] Unspit lines (optional) =
ok | [ cancel | [Enviconments...] [ ShowHelp>> | ‘;4
1

1)

When the tool opens, enter ENVIRON_MAREA2004_POLY as the Input features, and set

the output feature class to be CAINTROGIS\DATA\lakesponds.gdb\MAREA2004_POLY
_Dissolve. Remove the checkmark at the very bottom of the window (you will have to scroll
down) so that you do not create multipart features. Click OK.
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m) While the dissolve process is working, you can still work on your map. Called Background

n)

0)

p)

Geoprocessing, this is particularly evident during very complex, time consuming geoprocessing.
If you prefer, you can also turn off Background Geoprocessing from the Geoprocessing Options
window, available from the Geoprocessing menu.

You will know the dissolve process is working if you notice (eventually) the status

“Dissolve...Dissolve...” scrolling at the bottom of your screen. __-Dissolve...Disc<@ Pos:

When itis complete a green checkmark will appear, and the new data layer will be added to
your map.

The dissolved Managed Area layer does not contain any of those internal boundaries, nor does it
contain all of the information associated with the original data (when the polygons are lumped
together during this dissolve process, you are losing the attributes from the finer scale?)

<, Identify from: [ <Top-most layer> =
- MAREA2004_POLY Dissolve
19837.624045
4375.035456
13907.099577
1130326099
1602.614919 -
B3]
Location:  498,255.943 121,571,868 Meters X

Field Value

OBECTID 41

Shape Polygon
Shape_Length 19837.624045
Shape_Area  4395540.977649

iing= R EAs 0) Aral Identified 27 features

7. Calculate Acreage

a)

b)

c)
d)
e)
f)

You will now calculate the acreage of your new aggregated managed areas

Add Field ™ ot e
Right click on MAREA2004_POLY_Dissolve P
and choose OPEN ATTRIBUTETABLE. Name Acres

Type: [Double hd

Click the OPTIONS button at the top of the table.

Field Properiies

Choose ADD FIELD. Alias
Allow NULL Values Yes
Default Value

Name the new field “Acres” and set its type to Double.

Click OK.

| OK ] [ Cancel
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g) Right click on the new Acres field and choose CALCULATE GEOMETRY.

h) Click YEs to continue even though you are not in an edit session.

i) Setthe units to Acres US (ac) and click OK.

Calculate Geometry

[S5)

Property: [Area

)

Coordinate System
©) Use coordinate system of the data source:
PCS: NAD 1983 StatePlane Vermont FIPS 4400

") Use coordinate system of the data frame:

PCS: NAD 1983 StatePlane Vermont FIPS 4400

Units: [Acres Us [ac]

Calculate selected records only

About calculating geometr Cancel

8. Buffer Polygons

Now we will go back to the ponds and lakes data and select those that are at least 10 acres and

buffer them by 150 feet.

a) Click the SELECT BY ATTRIBUTES button at the top
of the winooskiWS_ponds attribute table.

e) Select all wetlands that are greater than or equal to
10 acres. Note that you must click the operator button
For >= (“greater than or equal to”). It will not work if you
click the > button and then click the = button!
(Doing that introduces an extra space)

c) Click AppLY, then CLOSE.

With those large ponds and lakes selected, you will now
run the buffer tool. You can find the buffer tool by hunting
around in the SYSTEM TOOLBOX, by using the SEARCH
window, or by going to the GEOPROCESSING menu.
Several of the most common Geoprocessing tools have
quick links from there (including Dissolve, which you
searchedfor earlier; it is helpful to know how to search
for tools!)
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Select by Attributes @

Enter a WHERE clause to select records in the table window.

Method : | Create a new selection V]
"OBJECTID" ®
"MAJ1"

"MINT"

"MAJ2

"MIN2 -
= =)

L

=] e

SELECT * FROM winooskiws_ponds WHERE:

"ACRES" >= 10

Clear ][ Verify ][ Help ][ Load... ][ Save... ]
o




a) From the GEOPROCESSING menu, choose BUFFER.

b)
c)
d)
e)
f)
9)
k)
h)

. Buffer (=[O [
E]
eature Class
C:\INTROGIS\DATA akesponds. gdb\winooskis _ponds_150ftbuf

Distance [value or field]

@) Linear unit

150 Feet -
©) Field

Side Type (optional)
OUTSIDE_OMNLY -

End Type (optional)
ROUND
Dissolve Type (gptional)

Dissolve Field(s) (optional)
[C] oBIECTID
] ma1
] M1
] masz
7] Mz

m

Set the input to WinooskiWwS_ponds and name the output winooskiwS_150ftbuf.
Set the LINEAR UNIT to 150 feet, the SIDE TYPE to ‘FULL’, and the DISSOLVE TYPE to All.
Click OK.

Open the attribute table for the buffers.

Click the OPTIONS button and choose AbD FIELD.

Name the field Acres and set its type to Double. Click OK.

Right click on Acres and choose CALCULCATE GEOMETRY

Set the units to Acres US (ac) and click OK.
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CHAPTER 12

Introduction to Geoprocessing:
Clip and Spatial Join

In this chapter, you will determine the existence and location of boating access recreation sites in

proximity to 10 acre or larger ponds and lakes in the Winooski W atershed, as well as identify the roads that

could lead you to those boating access sites.

You will clip the recreation boating sites layer to Washington County and evaluate how many points (if
any) fall within 150 feet of the lakes and ponds that are 10 acres or greater in area.

Next you will evaluate which roads lead to these access points. To do this, you will identify the roads and

clip them with the buffers. Then you will conduct a spatial join of the road segments to the recreation
sites. This will add attributes to the recreation sites table describing the nearest section of road and its

distance to the recreation site. Finally, you can work to symbolize the resulting data in a way that

effectively communicates your results.

1. Set Up Your Map Document

a) Open ArcMap. If it is already open, save the existing map and click the NEw MAP FILE button. EI

b) At the start screen, choose a template for your map.
Go to TEMPLATES - STANDARD PAGE SIZES

- NORTH AMERICAN (ANSI) and
highlight TABLOID (ANSI B) PORTRAIT.

c) Define a default geodatabase for the map

d) Click the browse button next to the defauli
geodatabase pathname.

g) Browseto CAINTROGIS\DATA\

h) Click on The NEw FILE GEODATABASE

button.

=
Q) Mg - Gettng Sawned

Capes aambiong uag e whe re g ey & Serglate

Default Geodatabase

|

| Look in: L CnticaliFaciities
‘ ; ) boatingsites

|
l
l
u
|
D

‘ Name: boatingsites .gdb

Show of type: | Geodatabases
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f) Name your new geodatabase boatingsites and hit enter.

g) Selectthe new geodatabase, boatingsites, and click Abb.

h) On the GETTING STARTED dialog, click OK.

i) Click the DATA VIEW button to switch away from LAYOUT VIEW.

j) Save your mapin the PROJECTS folder. Name it Winooski_boating_access.mxd.

k) Add the following data layers from the CAINTROGIS\DATA\folder:

i. BOUNDARY_TWNBNDS_POLY
i. TOURISM_RECSITES_BOATING_POINT
ii. TRANS_RDSMAJ1_LINE

I) And the following from your lakes and ponds geodatabase:
iv. WinooskiWS_ 150ftbuf
v. WinooskiWS_lakesponds

2. Clip a Data Layer

In this step you will clip the Recreation Sites layer to the boundaries of Washington
County. First you will need to select all the towns in W ashington County to form your clip

layer.

a) From the SELECTION menu, choose SELECT BY ATTRIBUTES.

b) Setthe Layer to BOUNDARY_TWNBNDS_POLY, and create the query “CNTY”

county code for Washington County.) Click OK.

S

!

=
Layer:
[7] Only show selectable layers in this list
Method: lCreaie a new selection V]
FID" A7
"FIPS6
TOWNNAME' 2
CNTY"
area"” -
=) =) (Ge)
> >= And
[o]
L No
Is Get Unique Values | Go To:
SELECT * FROM BOUNDARY_TWNBNDS_POLY WHERE:
"CNTY" =23
Clear ] [ Verify ] [ Help ] [ Load... ] [ Save... ]
ok J[ ey ][ Cose |

- —

c) From the GEOPROCESSING menu, choose CLIP.

d) Setthe INPUT layer to Recreation Sites.

23. (23 is the



e) Setthe CLIP layer to BOUNDARY_TWNBNDS_POLY. (Make sure you drag it in from the
TABLE OF CONTENTS or select it fr
system to find it. You need to u
County towns.

Input Features

ITOURISM_RECSHES_BOAHNG_PO
Clip Features

|BOUNDARY_TWNBNDS _POLY
Qutput Feature Class

L LY

| C:\INTROGIS\DATAboatingsites, gdb\Washington_boating_access

¥Y Tolerance {optional)

the drop-down menu -- do not browse out to the file
the layer in which you have selected the Washington

f)

the boatingsites.gdb geodatabase.

g) Click OK.

h)

IMeters

layer from your map by right-clicking on its name and selecting REMOVE.

3. Select By Location

Now you can figure out which, if any, of the boating site are
within 150 feet of a lake or pond 10 acres or more in size.

a) From the SELECTION menu, choose
SELECT BY LOCATION.

b) Selectfeatures from the target layer,

Washington_boating_access that intersect the source
layer, WinoooskiW Sponds150ftbuf

c) Click OK.

4. Create an Attribute Flag

In this step you will “record” the results of the previous step by
creating a new attribute in the boating sites attribute table, and
calculating its value for the selected records.

a) Openthe Washington_boating_access attribute table.

b) Click the OPTIONS button and choose ADD FIELD.

1 [ v S

Name the output feature class Washington_boating_access and confirm that it is being saved in

When the clip is complete, remove the statewide TOURISM_RECSITES_BOATING_POINT

-

Setet By Locatem S
Setoct featren Som ore & mOre teget lapers based o0 T ocadon
rewton s Pr et n Be surte aver
S Yo e Pod
el featses P
Target @)

¥ Naahingue_toatng_scieas
AL L0
Orty Show selectatie wyws n fa kot
St e
O wncodion_pond: 130%E
7 teate ey sewcsed)
Soot wecton metod & epet wym Stakseil
wiersect B sowrce e oo .
o Aoy A e S e
150 Feet
Sadasel i et o == Cre

c) Setthe Name to bufferpond the type to text, and the length to 1.
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x

Name: Ibuﬁerpund
Bee: e <]
— Field Properties

Alias bufferpond

Allow MULL Walues Yes

Default Value

Length 1

d) Click OK.

e) Right click on your new field (all the way at the end of the attribute table) and choose FIELD
CALCULATOR.

f) Remember that the only records selected right now are those that are in the buffer area; you are
going to calculate their boating access point value to “Y” for “yes.” Just type a Y in double quotes
(“Y”) in the window and click OK.

petscacumor I s

Parser
Q' VB Saript Python
Felds: Type: Functions:
OBJECTID o " Gmmber  [A3()
Shape = Atn( )
D s String Cos( )
SECCLASS EXD(( ))
Fix
Date

NAME Int( )
TELEPHONE ;?nq (( ))
ADDRESS sar( )
ADDRESS2 Tan( )
cmy
STATE 3

Show Codeblock N EEE

B J 21

‘w_,‘?'p“,,'a,, -

g) Now you will calculate the bufferpond value for all the other records to “N”.

h) Click the switch selection button at the top of the table. |

i) You should notice that different records are selected now. These are all the sites that are
not within 150 feet of the selected ponds.

i) Rightclick on bufferpond and select FIELD CALCULATOR.
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k)
1)

Type “N” in the window and click OK.
Clear selected features and save your map.

m) How many sites are in within 150 ft of a pond that is 10 acres or larger in size?

5. Perform a Spatial Join

In this final analytical step, you will perform a spatial join of the roads data to the boating access points.
This means that for each point the computer will calculate which is the closest road segment, and will
append its attributes (with its name, road class, etc.) to the boating access attribute table. It will also add
a new field, Distance, which will contain the distance (in feet) between the boating access point and the
closest road segment.

a)
b)
c)

d)

e)

f)

Right click on Washington_boating_access.
Choose JOINS AND RELATES > JOIN.
Choose to join data based on spatial location, and select the layer TRANS_RDSMAJ1_LINE

Choose the second option-- each point will be given all the attributes of the line closest to it, etc.

Join Data ——

| 3oinlets you append additional data to this layer's attribute table so you can,
for example, symbolize the layer's features using this data.

What do you want to join to this layer?

[20in data from another layer based on spatal location -

1. Choose the layer to join to this layer, or load spatial data from disk:

[& TRANS_RDSMAJI_LINE B

[
[ 2. Youare joining:  Lines to Points
Select a join feature dass above. You will be given different
| options based on geometry types of the source feature dass
and the join feature dass.
Each point will be given a summary of the numeric attributes of
the lines that intersect it, and a count field showing how many
lines intersect it

2

How do you want the atirbutes to be su

Average

) Each point wil be given al the attibutes of the line that is closest
to t, and a distance field showing how close that ine s {n the
units of the target layer).

3. The result of the join will be saved into a new layer.
Spedify output shapefile or feature dass for this new layer:

C\INTROGIS\DATArecstes_boating_washington gdb\Join_

About joining data Cancel |

Click the BROWSE button to name the output feature class. If necessary, browse to the default
geodatabase (you can click the Go To DEFAULT GEODATABASE button). Make sure the type is
set to Geodatabase feature classes (not shapefile) or it will not work. Notice the default name or
give it a new name!

Click SAVE and then OK.

6. Evaluate Your Results

a)
b)
b)

Open the attribute table for the joined data.
Scroll all the way across to the new “Distance” field at the end.

Right click on the field Distance and choose SORT ASCENDING. Note that some sites are
quite close (< 500 feet) to a boating access point.

How many sites are within 500’ of such roads? How many sites are within a mile of such roads?
How could you symbolize your results to communicate them effectively? If you have time, try
some different methods.
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CHAPTER 13 Layout View

Layout View is where you prepare your map for exporting, publishing, or printing. It is where you can add
all the extra elements that enable it to communicate its message to the reader: title, legend, scale bar,
north arrow, date, text about data sources, etc. It also functions a bit like Print Preview for your map —
you can see the page margins and how all these map elements will fit together on the page.

1. Explore Layout View

a) Ifitis not already open, open your Symbology.mxd map.

So far in this workshop, you have always been working in Data View. Now you will switch to Layout
View. Layout View is where you can add the elements that your map needs to be understandable to
someone else.

b) Click the tiny Layout View button at the bottom of the ArcMap interface.

@ symbology - ArcMap.
Fie Eat B

WINDSOR

[@a=n«
Drawing = R O- A< @ v0 v BI U AL i

¢) When you switch to Layout View, a hew toolbar becomes available to you: the LAYOUT TOOLBAR.
(It was probably already docked in your ArcMap interface, but until you switch to Layout View, it
is all grayed out.) If it is not yet docked, drag it toward the top of your screen and dock it up
there.

The LAYOUT TOOLBAR contains several tools that probably look familiar — they are very similar to the
navigation tools on the TooLs TooLBAR. To distinguish them, each of their icons has the image of a
sheet of paper in the background.

DAND0 BB EF% v DERMB

The navigation tools (like Zoom and Pan) on the LAYOUT TOOLBAR and TooLS TOOLBAR work quite
differently. The Layout tools will zoom and pan you around the map page —for example, to look closely at
the legend — while the zoom & pan from the TooLS TOOLBAR will move you around the data itself. You
can still use the data zoom and pan while you are in Layout view!
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The zoom and pan tools from the LAYouT toolbar will change your position on the layout itself -- they will
zoom in to the piece of paper, or move the paper to the right or left. They will not change the position of
the data in the map.

EEH EBBDOR % <] | B ™| oy
These tools zoom in, out, anYi\p@ around your page.

fo¥c]

The zoom and pan tools from the TooLs toolbar will zoom in or out of the data itself, or pan the data/
around, just like they did in data view.

KA MK
K¥ AK

W

d) Practice using the LAyouT toolbar. @
i. Pick up the zoowm tool, and draw a box to zoom in to the layout. -

ii. Pan around the map with the PAN tool. ;;]

iii. Zoom back out by clicking the Zoom TO FULL PAGE button. |7} 1y

o

44

é

7

e) Now compare what happens when you use the TooLs toolbar.
i. Pick up the zoowm tool from the TooLs toolbar, and draw a box to zoom into the data.

ii. Pan around the data with the PAN tool from the TooLs toolbar.

iii. Zoom back out by clicking the Zoom To FULL EXTENT button. O

2. Add a North Arrow and Scale Bar to your Layout
Without some standard map elements — such as a legend and scale bar — it may be difficult for others
to use your map.

a) From the INSERT menu, choose INSERT NORTH ARROW. Choose a north arrow style, and click OK.

b) The north arrow is placed on the map. It has “handles” at the corners that allow you to resize it, and
you can click in the middle and drag it anywhere on your page. If you decide you want to change
its style, just double click to open its properties and then you can change it.

c) Insert Scale Bar. Choose a style and Click OK.

d) To getthe scale bar to look the way you want it, you will have to open and manipulate its
properties.

e) Double-click on the scale bar to open its properties.
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Scale Line Properties x|

Scale and Lnits | Numbers and Marks | Format | Frame | Size and Postion |

Scale

Division value: 4mi

Number of divisions: 1 _Ij
Number of subdivisions: 4 j:

I~ Show one division before zero

L

When resizing. ..

l_

[~ Units

Division Units:

|Mi\es j
Label Position:

Iaﬁ:er labels j
Label: I Miles Symbal... |
Gap: |5‘11555_|:;'

ok | cancel | &)ph'\l\\

f) Onthe Scale and Units tab, try changing the instructions for resizing to “Adjust width.” Then you
can specify exactly how wide you want each division of the scale bar.

g) Try setting the units to Miles, the division length to 10, and the number of divisions to 5. Click OK
to see how this affects the scale bar. Feel free to play with these settings until you make it look the
way you want.

h) Save your map.

2. Add a Legend to your Layout

a) From the INSERT Menu, choose INSERT LEGEND. The Legend Wizard will appear.

b) Inthe first window, choose which layers to include in the legend. You may want to choose just
the census data, or the census data and the political boundaries. To add layers to the legend,
use the arrow button to move them from the left-hand pane to the right-hand pane.

c) Click Next through the next several windows until you can click Finish.

d) The Legendis placed on your map.

4. Insert a New Data Frame
Now you will insert a new data frame so your final map @ symbology - ArcMap
can_ _inCIUde two geographic areas -- O_ne a view of File Edit View Bookmarks Insert Selectior
B(;I;gcal boundaries, and the other a view of Census DR ES B = *-
ONCTE [ TR - < Ry
a) Rightclick on the name Layers at the top of your Table OFf Contents 7 x

Table of Contents -- this is the name of your current GCE 3
data frame (the only one now in your map). It is the | "= poptical Boundaries
default name that ArcGIS always gives to the first = [0 BOUNDARY_TWNBNDS_POLY

data frame in a map. Select PROPERTIES. 3
BOUMDARY_CNTYBNDS_POLY

b) Onthe GENERAL tab, make the name “Political

s o BIET Popuiston)
Boundaries.” Click OK. o 1 DEMO. COUSUB2010_POLY

P0030001

[10.000000 - 998.000000
[1998.000001 - 2326.000000

[ 2326.000001 - 5282.000000
I 5282.000001 - 12046.000000
80 I 12046.000001 - 42417.000000




c) From the INSERT menu, choose DATA FRAME. Your
map may disappear -- that is ok! In data view, you can
only look at one data frame at a time, and you are now
looking at your new, empty one.

d) Scroll down (if necessary) in the Table of Contents,
and right click on NEw DATA FRAME. Select PROPERTIES.

e) Onthe GENERAL tab, make the name “Population”

f) Click OK.

5. Copy Layers between Data Frames

The current “active” data frame will be in Bold type text in the Table of Contents, and only the layers
from this active Data Frame will be visible in Data View. If your new Population Data Frame is active (
you can make it active if it is not by right-clicking on its name and choosing “Activate”) and if you were
to click the Add Data button right now, the data would be added to the Population data frame, not the
Political Boundaries one. Another way to get data in to the data frame is just to copy or drag it in from
the other data frame — this will make a virtual copy of the data for viewing and mapping, not a real

copy.

a) Dragthe Census data from the Political Boundaries data frame down to the Population data
frame

6. Become comfortable Changing the Active Data Frame

Right now, the data frame Population is active--that s, it is visible in the DISPLAY AREA, and its scale is
reflected in the scale box at the top of the window, and if you were to pan or zoom, you would be doing
so in the Population data frame.

a) To view the Political Boundaries data frame, right click on Political Boundaries in the TABLE OF
CONTENTS, and select ACTIVATE. — note the scale

b) Return to the Population data frame by right clicking on Population and selecting ACTIVATE, and
notice that you are in a different scale now.

-

8. Arrange Data Frames in Layout View FQJE” o

a) Switch to LAYOUT VIEW by clicking the small paper icon at the bottom of the screen.

b) Temporarily turn off the census data in each data frame to speed up the time it takes
your map to redraw as you move things around.

c) Adjustthe sizes of the two data frames so that Political Boundaries takes up the entire
page, and Population is just a small box. You can adjust the size of a data frame by
selecting the data frame and dragging on any of its handles.
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@ symbology - ArcMap
File Edit View Bookmarks Insert Selection Geoprocessing Customize Windows Help

DEES $HB XD > &b 12358148 W EEE g edtorr
QAMQ NI« W-0I8O P R =

Table Of Contents B x T 12, 13, 14, 15, 16, 17, |8, 19, (10
Eossd

= £ Political Boundaries
& [ BOUNDARY_TWNBNDS_POLY

=
4 [@ BOUNDARY_CNTYBNDS_POLY

= @ DEMO_COUSUB2010_POLY
P0030001
[10.000000 - 998.000000
[ 998.000001 - 2326.000000
[ 2326.000001 - 5282.000000
I 5282.000001 - 12046.000000
1 12046.000001 - 42417.000000

110 111 112 113 114 115 118

14, 1516 pr 18 8,

13,

LR R

ag = n «
Drawing~ K () & (I~ A ~ %] ESRI Notth v®™2 v B I

Blc 5/0 @ @ (=& ®'a

Remember to use the Zoom and PAN tools from the TooLs toolbar, not the
LAYOUT TOOLBAR

d) Save your map.

8. Insert Text

a) Click on the NEw TeXT tool on the DRAWING toolbar.

b) Click anywhere at the top of the page to insert a text box.

y

| prawing > K &[0~ A~ = |[aial ~l~] 2 zu A- >~ g~ o~

AN

You are adding text in Layout view, so the text will stay with your map page as you zoom around
or change the extent of your data. This is just like how you added text labels in Chapter 6, butin
that case you added them in Data view, so the text stayed with your data as you changed its
extent.

¢) Change the font size to 24 (type it in the font drop down box, and press enter).

d) Double-click on the text box to bring up the TEXT PROPERTIES dialogue.
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Properties

Tedt | Size and Posttion

Text.
Political Boundaries and Population of Vermont - 2010

Fort:  Arial 24.00

Ange: 000 = Character Spacing: 0,00
Leading 000 =

#bout formatting text

‘

e) Type “Political Boundaries and Population of Vermont - 2010” in the title text box. Press OK.
f)  Drag the title to the top of the map.
g) From the INSERT menu, choose DYNAMIC TEXT > CURRENT DATE.

h) The date is added as a text box in the center of your map. Drag it to a bottom corner, and
make the font smaller.

i) Double click on the date to open its properties. You will see that it has the word Date: followed
by some tagged text that contains the code to insert whatever the current date is. Replace the
word “Date” at the beginning with “Map prepared:” Click OK.

- D ==
Properties L)
Text |Size and Position|

Text:

Map prepared: <dyn type="date" format="short"/>| -

1

1l
]
]

Font  Arial 7.00

Angle: 0.00 — Character Spacing:  0.00 =
Leading: 0.00 2
About Formatting Text J [ Change Symbol... ]
[ OK ] [ Cancel ] l Apply ‘

9. Adjust Legend Text in the Table of Contents

It is somewhat counter-intuitive, but in order to change the text in your legend, you need to make
adjustments to the layers themselves — either in the TABLE OF CONTENTS or through the layers’
Properties windows.

a) Make sure that the Population frame is the active frame.

b) Add a legend by selecting LEGEND from the INSERT menu. Note that the layers available in
the legend wizard are based on whatever frame is active right now.
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c) Click Next through the rest of the wizard pages to add the legend to your map. You will refine
it later.

d) Rememberthat the legend is looking at the data in the Population data frame. Therefore, to
change the legend, you need to change the look of the census data in the Population data frame
not the Political Boundaries one.

e) Inthe TABLE OF CONTENTS, change the layer name “DEMO_COUSUB2010_POLY” to “Population
2010.” You can do this by simply selecting the text and then clicking it again to make it
editable. Hit enter when you are done.

e) You can change the number formats for the housing vacancy categories in this same manner.
For example, if the text reads, “0.000 - 0.03000”, you can select it and change it to “Less than
3%” . “0.03001 - 0.08955” can become “3 - 9%”, and so on.

f)

If you want to change the actual symbology or classification of the data (e.g., make the classes
break at whole numbers, or at equal intervals), you will need to go back to the Symbology tab on
the Properties window, click Classify, and make your changes to the Label associated with each
Range.

g) Change the name Boundary CNTYBNDS in the Political Boundaries data frame to “County
Boundaries”.

g) Save your map.
10. Tips for Working with Legend Properties

NOTE: See below (step 11) if you are working with ArcGIS version 10.0 or earlier. The legend editor
has changed in version 10.1, and the instructions here pertain to v.10.1. or greater

To change the appearance of your legend (other than the wording, which you changed in the TABLE OF
CONTENTS, above), you need to open the legend properties. Do this by double-clicking on it or by right-
clicking and selecting PROPERTIES.

The Properties window has five tabs: LEGEND, ITEMS, LAYOUT, FRAME, and SizE & POSITION. Use the
arrow buttons on the General ta¥ if you want to add or remove any layers from your legend. The ITEMS
tab is where you will work to change many aspects of your legend’s appearance.

]

Legend Proghfties

;éeneml tems i{ygul l EIEME Vliélze an& Pi:smon’
Apply settings to selected item(s)

Font
Select Al || Select None

= | Apply to alllabels v
—_— ! \
pbp

v v

l;\“u/ o)

Map Extent Options

Only show dlasses that are visible in the current map extent

Show feature count

Item Columns

! Place item(s) in a new column

Style Column count for item(s) 15
I 0K Cancel
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For example, if you want to remove the heading P003001 from the population item in the legend -- so
that it only says “Population 2010” with the symbol colors and labels below it -- you would start on the Items
page. First you need to understand that “Population 2010” is the layer name, and “P003001” is the
heading, and text like “0-998” is a label. Click the Style button, and then choose from the list of legend
thumbnails one that does not show a heading, just the layer name ar&abels.

Legend Item Selector
— Preview
Heading - i. .......
|
Q&
N2
Horizontal Bar with Heading,  Horizontal Single Symbol
Labels. and Description Only
-
Propettes...
Horizontal Single Symbol _
Label Only Layer Name and Description More Siyies =
Save... Reset
Heading
Layer Name = oKk | Cancel

As you click on different styles, your choice is displayed in the preview thumbnail. The defaultis to
show the Layer Name, Heading and Label; it is often nice to instead choose a style that includes only
Layer Name and Label, or even just Label.

11. Working with Legend

If you want to make the “Legend” title go away (or change it to a different word), go to the LEGEND tab and
either click the check mark next to “SHow” (to hide the title) or type new text in the text window.

Legend Properties X

General ‘\ tems | Layout | Frame [ Size and Position |

Title

Legend
[] show
/ Specify Legend Items
Map Layers: Legend Items:
Census 2010 pbp
Manchester
“-pbp
(<) 4
| &)

Map Connection

[¥] Only display layers that are checked on in the Table Of Contents

[T]Add a new item to the legend when a new layer is added to the map
[¥|Reorder the legend items when the map layers are reordered

[7]Scale symbols when a reference scale is set

ok ][ Comcel J[ ooy |

Remove the checks from the check boxes at the bottom if you want items to stay displayed in the legend
even if turned off or re-ordered in the TABLE OF CONTENTS. It can be very frustrating to set up your legend
just the way you want it, only to have ArcGIS reorder it for you when you rearrange layers in your map.
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Use the FRAME tab to give your legend a frame (draw a line around it), a solid background (rather than
transparent) or a drop-shadow. Adding a value for a gap in both the X & Y directions for the border and the
background will make increase the size of the margin from the legend to the border.

f Legend Properties l _-m m

LLeAggnid l ltems ‘ Frame ‘ Size and Position‘

Border

| B Color: - v
Y: 0

-

Gap X 0 pts

Background \

~| pts  Rounding: 02

~[@

Color:

E

Gap X 0% pts Y 0% pts  Rounding: 012 o
Drop Shado/ /

7 H% Color: l v
Offset X B pts Y 1524 pts Rounding: 0129

[ Draft mode - just show name

[ OK } L Cancel ] [ Apply

12. Aligning Elements in a Layout

a)
b)

)

h)

Hold down the CTRL key, and select the both title text box and the Political Boundaries data frame.

Right-click and select ALIGN - ALIGN TO MARGINS. This turns on the ALIGN TO MARGINS option,
which means that the next alignment command you give will occur relative to the margins, not to
other objects on the page.

Right-click again, and select ALIGN - CENTER. Both objects are centered between the left and right
margins.

Hold down the CTRL key, and select the Population data frame, and then select the Political
Boundaries data frame (in that order).

Right-click and select ALIGN - ALIGN TO MARGINS. (This turns off the ALIGN TO MARGINS options.)

Right-click again select ALIGN - LEFT. The left side of the Population data frame, which was the
first object you selected, is aligned to the left side of the Political Boundaries data frame, which
was the last object you selected.

It may also be useful to add Guides to your map -- these are lines (invisible when printing) to
which you can snap and align objects. To add guides, simply click in the ruler area at the top and
side of the layout display window. If you don’t see the ruler or the guides, go to the View menu and
make sure both are turned on.

Save your map.
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APPENDIX 1 Suitability Analysis

A Suitability Analysis is the process by which a number of spatial datasets are used to narrow down a
‘search area’ using certain criteria specific to the data available that can help to find suitable locations for
specific goals. This sounds general because the possibilities are only limited by the data available. In this
exercise you are given a series of datasets that you can use to explore the potential of a GIS for
performing a Suitability Analysis. In CAINTROGIS\DATA\Suitability folder there are a number of datasets
downloaded from VCGI. The most common GIS tools used to perform a Suitability Analysis are the Clip
and Buffer tools that you were introduced to in Chapters 11 and 12. Another tool called Erase is also
commonly used, and demonstrated in the example below. The following is a simple example of a
Suitability Analysis that you can perform using the data provided in this folder, and | encourage you to
explore the other data stored in that folder, or even other data available on the VCGI site to perform your
own Suitability Analysis.

Example Analysis: Preservation and High Risk Soils

New funds have been made available to preserve agriculturally important soils that are at low risk of
heavy metal exposure in Chittenden County in Vermont. A simplistic initial approach to prioritizing
important preservation zones would be to create a map of those areas where large swaths of land with
important soils are beyond a certain distance to Roads because of runoff exposure, and a certain
distance to current/old landfills for reduced leaching exposure.

1) In anew map document, bring in the following shapefiles from the Suitability folder: Counties,
Agriculturally Important Soils, Landfills, and Roads
2) Clip all layers to Chittenden county
a. Select Chittenden County from the Counties layer
i. A quick method is to right click the layer and choose label features, so that if you
do not know where it is you will be able to see the polygon, then to use the select
features button to click Chittenden county to select it
ERANQIil «= [T

FRAMKLIN ORLEANS

LAMOILLE
CHITTENDEN

WASHINGTON

/

b. Use the Clip tool for each layer (note that by having Chittenden county selected in the
Clip Features layer, the clip will be restricted to that area — use this process for the other
layers as well' (note that the soils layer is already limited to Chittenden county)

1Ol x|
Input Features =l Qutput Feature =l
| Landfils / | [,:_:}l Class
Clip Features
— S - o+ The feature class to be

Icounhes =} created.
Output Feature Class
[[C-INTROGIS \Suitabitty V. andfils_Cip.shp
XY Tolerance (optional)

Meters j
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3) Create a 1000 meter buffer around Landfills, and then a 100 meter buffer around Roads — You
will have to use the tool once for Landfills and once for Roads

"\, Buffer

Y

Input Features
| Landfils_ciip | &
Output Feature Class
| C:\INTROGIS \suitability \Landfills_buffer.shp B

Distance [value or field]

%" Linear unit

| 1000 |Meters |
" Field

I -|

4) Use the Erase tool (ArcToolbox | Analysis Tools | Overlay | Erase) to remove those Soils areas
within both the Landfills and Roads and buffers (high risk areas) — you will have to use the tool
once for Landfills and once for Roads

*, Erase

Input Features e
I.ﬁ.gril:uthraIIy Impartant Soils ;I E;
Erase Features
| Landfils_buffer | &
Output Feature Class
I C:\IMTROGIS\Suitability'\Soils_Erase.shp E
XY Tolerance (optional)
I Meters j
5) Remove all but the pertinent layers
Table Of Contents [
3 C8|H o
E = Layers
= Soils =
PRIME —
[ Prime :
M Frime (f) :
[=3 4
M statewide —
M statewide (a) :
M statewide (b) m:
B O Landfils_clip -
. :
= [ Roads_dip r-u
= Counties :
a o
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6) Construct Map in Layout view — It is up to you to decide what to include on your final map

Low Risk Agriculturally Important Soils in Chittenden County

Soil Category
I Prime
B Frime ()
B Sistewide

B stetewice sy 0 35 7 14 Miles

B Statewide (b) T T Il A B
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APPENDIX 2 Unstructured Exercises

The following are a series of unstructured exercises where you must
download spatial data and bring it into ArcGIS and make a map.

1)

Map of New England

(Connecticut, Maine, Massachusetts, New Hampshire, Rhode Island, Vermont)

Utilizing any of the data resources listed on danjarvis.net/GIS/ArcGlS/Data Sources.txt,
or others you can find, create a visually appealing map of the United States that
includes at least major roads, state boundaries, major lakes, and major rivers. Any
additional information / layers you wish to include is completely up to you. If you like,
you can theme your map using environmental data, socioeconomic data, or anything
else of interest to you. Keep in mind that the choice of projection must be a deliberate
one.

Tips:

- Start with a map of the entire United States, then use any of the following methods
to extract New England for your map: clip, select and export, definition query, others

- You can either project your data to your desired projection, modify the data frame’s
projection, or if you believe the project information is fine the way it is you can leave
it — the important thing to remember about projections is that you need to be
conscious of how you projection makes you map look when looks are what matters,
and conscious of how projection affects calculations if they are performed

- Use Symbology and Layout view to prepare your map

- Itis your choice if you think an inset map makes sense

Export your map when you are done.
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2)

New Highway

The Vermont Agency of Transportation is considering the construction of a new highway
in the southwest quadrant of the state. Assume this highway might stretch from
Randolph to West Haven. Using a towns layer and a roads layer as reference, digitize
this new highway across the state, stretching between these two towns. Once you’ve
created this new highway, create a map that only includes those towns affected by the
new road. Include any other data you feel are important for someone to consider when
a large road is being constructed — maybe environmental impacts (layer of sensitive
environments, animal habitats, important soils, water resources, etc. — one of these
could be the main focus on the map)

Tips:

- Start with a map of Vermont, then use any of the following methods listed in first tip
of the ‘Map of New England’ exercise above

- Use the editor toolbar to create your road (creating a new feature class in catalog
wouldn’t be a bad idea) — you could also use graphical elements if you'd prefer

- To select out the towns you need, you could use select by location, manual
selection, or another method

- If you choose some environmental variable, you will likely need to create a buffer
around your new road and use clip to clip the variable by the buffer

3)

Deer Crossing Risk

The state of Vermont has updated its inventory of deer wintering areas and needs to
create a map of high risk areas of automobile collisions. Go to VCGI and search for
‘deer’ to download the deer wintering areas data set. Also download a roads layer, a
towns layer, and any other layers you feel might be relevant to deer-car collision risks.
Make a pleasing map.

Possible approaches:

- Use the Intersect tool with Deer and Roads as inputs, and LINE as the output type

- Use the Buffer tool to make a Buffer around the Deer wintering areas and use the
buffer to clip out roads
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